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Description 

This Basic level course provides instruction in the use of GEOPAK, MicroStation, and the FDOT 
CADD standard resources and applications for roadway design. The basic course follows typical 
roadway design workflow to instruct students how to produce and present alignments, profiles 
and plan sheets for roadway projects. 

Topics Covered  

 
• FDOT Standards 
• Starting a GEOPAK Project 
• COGO & Horizontal Alignments 
• Design & Computation Manager 
• Existing Ground Profile 
• Plan View Labeler 
• Draw Cells with GEOPAK 
• Plan and Profile Sheets 

Prerequisites 

• FDOT MicroStation Essentials - Part I (CE-11-0114) 
• FDOT MicroStation Essentials - Part II (CE-11-0115) 

Duration: 16 Hours    

Professional Credit Hours:  14 PDHs 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright © 2011 by Florida Department of Transportation 
All rights reserved 

 
For information about this and other CADD training courses, publications, videos, and Frequently Asked 

Questions, visit the Engineering/CADD Systems Office of the Florida Department of Transportation on the 
world-wide web at http://www.dot.state.fl.us/ecso/ 

http://www.dot.state.fl.us/ecso/�


 



Table of Contents 
 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT i 

1 FDOT STANDARDS................................................................................................................................ 1-1 

FDOT/CADD STANDARDS OUTLINE .................................................................................................................... 1-1 
MICROSTATION STANDARDS ................................................................................................................................. 1-2 

To start MicroStation ..................................................................................................................................................... 1-2 
GEOPAK STANDARDS .......................................................................................................................................... 1-3 
FDOT DIRECTORY STRUCTURE............................................................................................................................. 1-5 
MICROSTATION FILE NAMING CONVENTIONS ....................................................................................................... 1-7 
CREATE FILE/PROJECT FILE .................................................................................................................................. 1-7 

To access Create / Edit File ............................................................................................................................................ 1-7 
Exercise 1.1 Creating MicroStation Design File and Setting Plot Scale ................................................................ 1-9 

JOURNALING ........................................................................................................................................................ 1-14 

2 STARTING A GEOPAK PROJECT ....................................................................................................... 2-1 

ACCESSING GEOPAK ROAD MODULE .................................................................................................................. 2-1 
PROJECT MANAGER ............................................................................................................................................... 2-3 

Projects Menu .................................................................................................................................................. 2-5 
Directory Menu ................................................................................................................................................ 2-7 
Admin Menu ..................................................................................................................................................... 2-8 

PREFERENCES ........................................................................................................................................................ 2-9 
Feature Preferences ....................................................................................................................................... 2-11 
COGO Preferences ........................................................................................................................................ 2-12 

Exercise 2.1 Accessing GEOPAK and Creating a Project ................................................................................... 2-13 
PROJECT USER ..................................................................................................................................................... 2-17 

Exercise 2.2 Creating a New ............................................................................................................................... 2-19 
ROAD PROJECT DIALOG BOX .............................................................................................................................. 2-21 

Road Project menu bar .................................................................................................................................. 2-22 
Working Alignment ........................................................................................................................................ 2-22 

Exercise 2.3 Creating a Working Alignment ....................................................................................................... 2-28 

3 COGO & HORIZONTAL ALIGNMENTS ............................................................................................. 3-1 

INTRODUCTION TO COGO ..................................................................................................................................... 3-1 
OPENING COGO .................................................................................................................................................... 3-1 
COORDINATE GEOMETRY MENU BAR ................................................................................................................... 3-4 

File Commands ................................................................................................................................................ 3-5 
Edit Commands ................................................................................................................................................ 3-7 
Element Commands .......................................................................................................................................... 3-8 
View Commands ............................................................................................................................................. 3-13 
Tools Commands ............................................................................................................................................ 3-16 

NAVIGATOR ......................................................................................................................................................... 3-20 
Element Type .................................................................................................................................................. 3-21 
Navigator Toolbar .......................................................................................................................................... 3-22 
Select Commands ........................................................................................................................................... 3-23 
Tools Commands ............................................................................................................................................ 3-24 
Exporting to LandXML .................................................................................................................................. 3-25 

MISCELLANEOUS COGO KEY-IN COMMANDS .................................................................................................... 3-27 
Exercise 3.1 Opening COGO .............................................................................................................................. 3-29 
Exercise 3.2 Storing a Point ................................................................................................................................ 3-32 

GRAPHICAL COGO INTRODUCTION .................................................................................................................... 3-36 
Store Elements Toolbox.................................................................................................................................. 3-37 
Modify Elements Toolbox ............................................................................................................................... 3-40 
Manipulate Elements Toolbox ........................................................................................................................ 3-41 
Groups Toolbox.............................................................................................................................................. 3-41 

Exercise 3.3 Using Graphical COGO .................................................................................................................. 3-42 



Contents ______________________________________________________________  
 

ii © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

Exercise 3.4 Storing a Chain ............................................................................................................................... 3-48 
Exercise 3.5 Describing a Chain .......................................................................................................................... 3-50 
Exercise 3.6 Saving the Input Trail ..................................................................................................................... 3-51 
Exercise 3.7 Saving the Output File .................................................................................................................... 3-52 
Exercise 3.8 Creating the ASCII Geometry Input File ........................................................................................ 3-54 
Exercise 3.9 Updating the Working Alignment ................................................................................................... 3-55 

4 DESIGN & COMPUTATION MANAGER ............................................................................................ 4-1 

OBJECTIVES ........................................................................................................................................................... 4-1 
ACCESSING THE D&C MANAGER .......................................................................................................................... 4-1 
D&C MANAGER DIALOG BOX .............................................................................................................................. 4-3 

D&C Manager Menu Bar ................................................................................................................................ 4-3 
D&C Manager Operational Modes ................................................................................................................. 4-4 
Exploring FDOT’s .DDB File .......................................................................................................................... 4-6 

DESIGN MODE ....................................................................................................................................................... 4-8 
Plotting COGO Elements that are Default or Calculate Items ........................................................................ 4-9 
Plotting COGO Elements Using Drafting Standard Items ............................................................................. 4-10 

Plotting COGO Chains................................................................................................................................................. 4-12 
Plotting Stationing on the Chain .................................................................................................................................. 4-13 

Exercise 4.1 Plotting & Stationing the Horizontal Alignment or Chain .............................................................. 4-14 
ADHOC ATTRIBUTES ............................................................................................................................................ 4-19 

Exercise 4.2 Drawing Plan Elements with Adhoc Attributes .............................................................................. 4-20 
Exercise 4.3 Drawing Edge of Pavement through Transition .............................................................................. 4-23 
Exercise 4.4 Checking Adhoc Attributes ............................................................................................................. 4-26 

DRAW TRANSITION TOOL .................................................................................................................................... 4-27 
Exercise 4.5 Drawing Guardrail .......................................................................................................................... 4-29 
Exercise 4.6 Drawing Paved Shoulder ................................................................................................................ 4-30 
Exercise 4.7 Drawing Curb & Gutter .................................................................................................................. 4-32 
Exercise 4.8 Draw Sidewalk ................................................................................................................................ 4-33 

DISPLAY MODE ................................................................................................................................................... 4-35 
Exercise 4.9 Checking elements using the Display Mode ................................................................................... 4-37 

5 EXISTING GROUND PROFILE ............................................................................................................ 5-1 

OBJECTIVES ........................................................................................................................................................... 5-1 
ACCESSING GROUND PROFILE DIALOG BOX ......................................................................................................... 5-1 
DRAW PROFILE TOOL ............................................................................................................................................ 5-4 

Surfaces Tab ..................................................................................................................................................... 5-9 
COGO Tab ..................................................................................................................................................... 5-13 
Projection Tab................................................................................................................................................ 5-15 

REVIEWING THE PROFILE ..................................................................................................................................... 5-16 
Profile Report ................................................................................................................................................. 5-16 
Drawing Profiles with D&CManager ............................................................................................................ 5-18 

DRAW PLAN & PROFILE ...................................................................................................................................... 5-18 
Profile ............................................................................................................................................................ 5-20 

Exercise 5.1 Creating Existing Ground Profile .................................................................................................... 5-23 
Exercise 5.2 Display Existing Ground Profile In COGO .................................................................................... 5-29 
Exercise 5.3 Updating the Working Alignment ................................................................................................... 5-31 

6 PLAN VIEW LABELER ......................................................................................................................... 6-1 

OBJECTIVES ........................................................................................................................................................... 6-1 
ACCESSING THE PLAN VIEW LABELER .................................................................................................................. 6-1 
GEOPAK - PLAN VIEW LABELER OVERVIEW ....................................................................................................... 6-3 

Text Tab ........................................................................................................................................................... 6-5 
Params. Tab ..................................................................................................................................................... 6-8 
Shape Tab ......................................................................................................................................................... 6-9 
Leader Tab ....................................................................................................................................................... 6-9 



 ______________________________________________________________ Contents 
 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT iii 

Rotate Tab ...................................................................................................................................................... 6-10 
Styles Tab ....................................................................................................................................................... 6-11 
Plan View Labeler Menu Bar ......................................................................................................................... 6-12 

Exercise 6.1 Placing a label using FDOT’s style file .......................................................................................... 6-14 
Exercise 6.2 Creating a Custom Label................................................................................................................. 6-19 
Exercise 6.3 Modifying a Style ........................................................................................................................... 6-26 

7 DRAW CELLS WITH GEOPAK ............................................................................................................ 7-1 

DRAW CELL BY FEATURE ...................................................................................................................................... 7-1 
DRAW CELL GROUP BY FEATURE .......................................................................................................................... 7-4 

Feature Group Tab .......................................................................................................................................... 7-5 
Location Tab .................................................................................................................................................... 7-6 

Exercise 7.1 Drawing Cells by Feature ................................................................................................................. 7-7 
Exercise 7.2 Drawing Cell Groups by Feature ...................................................................................................... 7-9 
Exercise 7.3 Drawing Cell Group by Feature (Transition) .................................................................................. 7-11 

8 PLAN AND PROFILE SHEETS ............................................................................................................. 8-1 

OBJECTIVES ........................................................................................................................................................... 8-1 
ACCESSING THE PLAN/PROFILE SHEET COMPOSITION DIALOG BOX ..................................................................... 8-1 
GEOPAK SHEET LAYOUT OVERVIEW .................................................................................................................. 8-3 

File Menu ......................................................................................................................................................... 8-3 
View Menu ....................................................................................................................................................... 8-5 
Tools Menu ....................................................................................................................................................... 8-6 
GEOPAK Sheet Layout Buttons ..................................................................................................................... 8-22 
Sheet Name Selector and Plot Scale .............................................................................................................. 8-22 

Exercise 8.1 Creating Motif Files ........................................................................................................................ 8-23 
Exercise 8.2 Creating the Clip Borders Design File ............................................................................................ 8-28 
Exercise 8.3 Creating Plan & Profile Sheets ....................................................................................................... 8-38 

  



Contents ______________________________________________________________  
 

iv © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

  



Using This Manual _______________________________________________________  
 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT i 

This manual closely follows the Microsoft standards to standardize text for the user. Look 
at the sample and explanation of the formatting below. 

Each procedure is set up in sequential steps. Words written in bold type also appear on 
your screen. Words in Arial font are the names of windows, dialog boxes, or messages 
that open after you perform a step. These names are always located in the title bar at the 
top of the window or box in question. 

Each procedure has a title statement beginning with the word “to”. Some exercises 
contain more than one procedure. When you are using this manual in class, you may not 
need the sort of detailed information in the procedures. However, the manual will guide 
you, after the course is over, when you are attempting these procedures in your office. 
Remember, the project shown in the graphics is for the training class only. 

Sample procedure 
 TO CREATE A SEED PROJECT 
In EDI2, in the Creating and Preparing a Seed Project folder, click Launch as shown 
below. Create New FDOT Project opens as illustrated on the following page. 

 

 

 

 

 

 

  



 _______________________________________________________ Using This Manual 
 

ii © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

 

Notes, tips, or cautions, as applicable, may accompany each procedure.  

• A note is additional useful information that is not necessary for performing 
the procedure.  

• An important note contains information that you need to perform a 
procedure.  

• A tip contains actions that supplement what you do in the procedure, usually a 
different way to do something that you may prefer.  

• A caution indicates an action that may irreparably damage your data if 
performed incorrectly. Be sure to look for cautions and read them carefully.  

• A warning indicates an action that could hurt you or damage your hardware. 
This manual does not contain any warnings.  
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1 FDOT STANDARDS 

FDOT/CADD STANDARDS OUTLINE 
The Florida Department of Transportation (FDOT) Engineering/CADD Systems Office 
(ECSO) maintains the MicroStation and GEOPAK standards used to produce plans for 
the FDOT. These standards aid in the production of a design project. The Computer 
Aided Drafting and Design (CADD) standards keep file naming, symbology and 
directory structure consistent from project to project. Consistency is essential for 
successful automation of processes and the final Electronic Delivery of projects. The 
CADD tools and programs provided by the ECSO save time as work progresses on 
projects, while maintaining standards. The CADD Production Criteria Handbook 
(CPCH), a companion to the FDOT CADD Manual, outlines the minimum standards, 
conventions and formats necessary to ensure a usable CADD data set to the downstream 
customers. We highly recommend that you download and review this manual from the 
following website: www.dot.state.fl.us/ecso/downloads/publications/. 
In some situations, the standards may not be sufficient, and you must vary from the 
standards. If variations from the FDOT CADD Manual or CPCH are necessary for a 
project, approval for such variations must be in writing by the FDOT Project Manager 
and documented in the project journal. 

Each district office has a CADD Manager who is the primary contact for support for all 
CADD issues. The Central Office is available for further support. The ECSO support 
page, www.dot.state.fl.us/ecso/, provides access to download or open the CPCH for the 
FDOT CADD Standards and the CADD Customer Support Guide for primary contact 
personnel. The ECSO web page, www.dot.state.fl.us/ecso/main/version/version.shtm, 
lists the current versions of software used by FDOT. 

FDOT has an internal support call logging and tracking system, which tracks your call 
and used by ECSO support staff to search other logged support calls to help solve your 
issue.  Users may gain access to this system to submit an issue through the website:   

http://www.surveymonkey.com/s.aspx?sm=vpH3GFrro8xuDfrcuBSVFw_3d_3d 

Contact ECSO at (850-245-1600) or (866-374-3668), if you need to talk with a support 
analyst or email your issues and comments to:   ecso.support@dot.state.fl.us. 

  

http://www.dot.state.fl.us/ecso/downloads/publications/�
http://www.dot.state.fl.us/ecso/support�
http://www.dot.state.fl.us/ecso/main/version/version.shtm�
http://www.surveymonkey.com/s.aspx?sm=vpH3GFrro8xuDfrcuBSVFw_3d_3d�
mailto:ecso.support@dot.state.fl.us�
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MICROSTATION STANDARDS 
The FDOT CADD tools are available in the FDOT 2010CADD software package.  
Consultants can acquire the software from the FDOT Maps and Publications website. 
After installing the FDOT 2010 software, a FDOT2010 shortcut icon appears on your 
desktop.  

From the desktop, double-click the FDOT2010 icon.  
TO START MICROSTATION  

From the FDOT2010 folder, double-click the    icon. MicroStation Manager 
opens.  

 

In MicroStation Manager, three list boxes are available: User, Project, and Interface.  

The User list contains configuration files. FDOT only provides an English configuration 
file. When selecting the FDOT2010 icon on the desktop, set the User to FDOT2010 and 
the correct resource files will load ensuring that the text and lines look correct based on 
the units.  

The Project list contains the project configuration file (PCF), which changes the current 
directory to the selected project directory. The information in this file supplies the title 
block information for Sheet Navigator.  

The Interface list contains FDOT provided preferences in the form of a resource file that 
contains the toolboxes associated with the workspace.  Modify these Workspace 
preferences by clicking Workspace and then Preferences within MicroStation.  Exercise 
caution when modifying the Workspace. 

The MicroStation support files delivered with the FDOT 2010 CADD software and their 
location in the FDOT2010 directory structure are as followed: 
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• Cell Libraries: \FDOT2010\RESOURCES\Cell 
• Font Resource Files: \FDOT2010\ RESOURCES\Fonts 

• Line Style Resource Files: \FDOT2010\ RESOURCES\LineStyles 

• Color Table: \FDOT2010\ RESOURCES\Data 
• Seed Files: \FDOT2010\ RESOURCES\seed  
• Plot Drivers: \FDOT2010\ RESOURCES\plot  

GEOPAK STANDARDS  
In addition to the MicroStation standard support files, there are several GEOPAK support 
files created to enable working compliancy with FDOT standards. The ECSO maintains 
these files and distributes them to the districts in the same manner as the MicroStation 
standards. The following are the standard folder locations for the different files: 

• Cross Section Criteria Files: \FDOT2010\GEOPAK\typicals 

• Drainage Criteria Files: \FDOT2010\GEOPAK\criteria 

• 3pc Files: \FDOT2010\GEOPAK\3pc 

• Plan and Profile Sheet Clipping Library: \FDOT2010\GEOPAK\dat_files 

• Design & Computation (D&C) Manager Database:  

\FDOT2010\GEOPAK\databases 
• Super elevation Tables: \FDOT2010\GEOPAK\e_tables 

• K-Value Tables: \FDOT2010\GEOPAK\bin 

• Plan Labeler Style Files: \FDOT2010\GEOPAK\bin 

• Survey Manager Data Base: \FDOT2010\GEOPAK\databases 
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GEOPAK creates and uses a number of important files during this training course. The 
following are common files used: 

job###.gpk  (Example: job527.gpk) This binary file is created when a 
coordinate geometry (COGO) session starts for the first time or through 
Project Manager.  This file stores all coordinate geometry elements with 
users appending data throughout the design process.  Multiple users can 
access this file at the same time, but only one file should exist for each 
project.  The “###” represents the job number (up to three alphanumeric 
characters) unique to a project and is defined upon creation.  

fname###.ioc  (Example: main527.ijd) This is an ASCII input file for loading 
data during a COGO session. The ### represents the job number and oc is 
the operator code (usually the users initials). Filenames are limited to 15 
characters (no spaces) plus the job number designation as indicated with 
the example. This file is a backup of stored alignments. 

fname###.ooc  (Example: main527.ojd) This is an ASCII output file created by 
GEOPAK during a COGO session. Variables are the same as defined 
above.  Filename characters are limited to 15 characters (no spaces) plus 
the job number designation as indicated with the example. QC reviewers 
print this file through COGO to compare the geometry from COGO with 
the plans. 

fname.inp  (Example: earthxs.inp) Any ASCII input file for running GEOPAK 
processes.  Name is user defined with an .INP extension. 

fname.dat  A binary (preferred) or ASCII file, containing string and point 
information. The user utilizes this file to create the TIN file. 

fname.tin  A binary file, containing triangular surfaces, also known as the 
digital terrain model (DTM).  The user utilizes this file to cut existing 
cross sections and profiles. 

Project-name.prj     A binary file created by GEOPAK Project Manager with a 
new project.  
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FDOT DIRECTORY STRUCTURE  
FDOT has a standard project directory (see chapter 4 in the CPCH for more details) and 
structure-naming convention. The project directory name is the eleven-digit FDOT 
Financial Project Identification number (FPID).  A typical FDOT project directory 
structure displays below. 
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The project directory structure is a list of the required directories. These directories are 
required in the hierarchy as shown and must remain intact. Even when a directory is 
empty in a specific project, the directory shall remain intact. 

 The Discipline subdirectories define for the division of work by ownership, not 
necessarily by the type of work. As the various disciplines develop files, they store each 
file in the project subdirectories corresponding to the creator of the work. Roadway 
designers typically place their files (the files they create and own) under the Roadway 
subdirectory. Surveyors place their files under the Survey subdirectory, etc.  

In some cases, work overlaps disciplines. For example, if a roadway designer develops 
the drainage sheets, using the above convention, then the roadway designer is the owner 
of the work and the Roadway directory stores those files, rather than the Drainage 
directory. There are situations causing files to be placed in the Drainage subdirectory, but 
users must consider directory permissions and electronic signing and sealing questions. 
For example, does the roadway designer have permission to write to the Drainage 
subdirectory, or is merging files across multiple disciplines (i.e., multiple copies of the 
files) a problem. Each user should be aware of the possible problems to encounter with 
duplicate file names. Reference file attachments may not work correctly due to the first 
occurrence of the file name is the actual file attached. 

Proper location of working files within the project demands common sense. Contact the 
appropriate Project Management staff for advice or referral. Documentation is required 
for all deviation from standard practice in the appropriate discipline journal file (Section 
1.7 Journaling). 

Each discipline subdirectory contains an additional subdirectory named \eng_data. These 
designated subdirectories contain the PostScript image files of the plan sheets for that 
discipline, the QC reports, and the ASCII Engineering Data output files. For more 
information regarding the files stored in the \eng_data subdirectories, see Chapter 3 of the 
FDOT CADD Manual and an extensive description of the Engineering Data requirements 
in Chapter 8 of the CPCH. Some disciplines may require additional Engineering Data 
information, in which case, the additional requirements are in the discipline specific 
chapters of the CPCH. 

The discipline specific subdirectories can create additional directories to accommodate 
additional segregation of work. Do not create additional directories at the same level as 
the standard discipline subdirectories. Custom subdirectory names shall not exceed 16 
characters and shall contain only alphanumeric characters, dashes and underbars with no 
other characters allowed. Refer to chapter 4 of the CPCH for more detail.  
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MICROSTATION FILE NAMING CONVENTIONS 
All design files use the following file naming conventions, standard input files and 
GEOPAK criteria files. In the event a particular file type that is needed for the project is 
not addressed by this document, use the file naming convention as a template for 
selecting an appropriate name, or consult with either the Project Manager or the district 
CADD Manager to determine the proper file name. Document all files, both standard and 
project specific, in the Project Index and Journal files (Section 1.7 Journaling). 

Note The standard file names created for each discipline are located in the Standard File Name 
section of their respective discipline chapters of the CPCH.  

Standard file names should follow the following format: AAAABB##.ext  
AAAA = abbreviated file description, BB = discipline denotation, ## = sequence number, 
ext = file extension indicating the type of file. 

Example:  The first roadway cross section file name created in a project would have the name 
rdxsrd01.dgn.   

Typically, the sequence is limited to two digits, except for large projects. There are 
occasions when additional descriptive information is necessary in the filename, this 
descriptive information should be inserted after the discipline denotation BB and 
preceding the sequence number ##. However, the length of additional descriptors should 
be to a minimum. 

 Example:  rdxsrdrmpa01.dgn, indicating this cross section file includes ramp A. 

CREATE FILE/PROJECT FILE 
FDOT has a tool within FDOT Menu, Create / Edit File, to aid in the creation of 
standard files used on FDOT projects.  

In MicroStation, on the FDOT Menu, click Actions and then click Create/Edit File as 
shown in Figure 1-4 --or-- click Roadway and then click Create/Edit File --or-- double 
click the desktop icon for CreateEdit.exe as illustrated below. Create File/Project opens 
as shown below.  

TO ACCESS CREATE / EDIT FILE 
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Exercise 1.1 Creating MicroStation Design File and Setting Plot Scale 
 TO CREATE A MICROSTATION DESIGN FILE AND SET PLOT SCALE 

1 . Extract the project files by double-clicking on the file C:\Chapter1_Ex1_1.exe. 

2 . From the desktop, double-click the FDOT2010 folder icon. A window opens with 
the FDOT2010 icons.   

3 . Open Create/File Project by double-clicking the Create Files icon as shown 
below. 
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4 . From Create File/Project, click the Project Settings button. Project Settings opens 
as shown below.  

  

5 . Click the Select Active Project button. Select Active Project opens. 

 

6 . From Select Active Project, click the Browse button, then navigate to 
C:\e\projects\96385275201 on the Choose Folder dialog and click the Select 
button.  
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7 . From Select Active Project dialog, click the OK button. Select Active Project 
closes. 

8 . From Project Settings dialog, click the OK button. Project Settings closes. 

9 . From Create File/Project dialog, click on the Control File: list and select 
ROADWAY.CTL from the dropdown list as shown below. 

 

10 .On Create File/Project dialog, click on the File Group: list  and select Roadway 
Design Files (DGN) from the dropdown list as shown below. 
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11 .In the File Type: list, click PROPOSED DESIGN as shown below.  

 

12 .Click the Create button. Create /Edit File displays the message “File successfully 
created”.   

 

13 .Click OK to close message and return to the Create File/Project dialog.  The 
Open DGN button becomes available and the Output Filename increments by 
one.   

14 .Click OK on Create File/Project to close the Create File/Project dialog box. 
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15 .Within the FDOT2010 folder, double click on the FDOT2010 icon to open 
MicroStation. 

   

16 .From the MicroStation Manager navigate to:   
C:\e\projects\96385275201\roadway, select the file DSGNRD01.dgn and click 
Open.  
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17 .From the FDOT Menu, click the menu option Actions > Set Plot Scale of File.  

Note When opening the design file using the Open DGN option in Create File/Project, 
Set/Update Plot Scale will automatically open. Set/Update Plot Scale 
opens. 

 

18 .In the Scale box, type 50, set the Units to English, and then click the OK button. 

  

Note Setting the plot scale writes a type 66 element defining the scale to the file.  When selecting 
other items from the FDOT Menu, such as cells or text, their default size is set according to 
the plot scale.  Selecting the Process File List allows the plot scale to be set for a group of 
files.  For example, if PLANRD*.DGN is typed in the File List box, all plan sheets are 
processed.  Likewise, if *.DGN is typed in the File List box, all .dgn files in the directory are 
processed. 

19 .Exit MicroStaion. 

JOURNALING 
The FDOT CADD software includes a Journal application to create and edit journal files, 
as part of the Electronic Delivery process. Each user shall maintain journal files during 
the life of the project and deliver them in accordance with the FDOT CADD Manual. The 
purpose of the Journal files is to detail design aspects and decisions made during the life 
of project. 

Journal File entries should document methods employed, procedures used, decisions 
made, problems encountered, fixes included or other issues encountered during the 
design process. The user shall record any information that assists in the regeneration of 
CADD files and or plots. The user shall also record the geometry information, database, 
controlling alignment, profile names, relevant survey and cross section information and 
the methodology used to obtain the final geometric controls in the CADD product. 

The participant in this class will create and maintain a journal file to keep with the normal 
workflow and documentation of GEOPAK processes of a project design.  Refer to the 
Electronic Delivery training manual for additional information. 
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2 STARTING A GEOPAK PROJECT 

ACCESSING GEOPAK ROAD MODULE  
The GEOPAK Road module provides tools to design roads including production of 
various sheets required in a construction set of plans. GEOPAK also provides means to 
produce drawings and output files that are in accordance to defined standards while 
increasing efficiency and the ability to automate processes. 

GEOPAK is loaded from within MicroStation and is not a stand-alone product. The 
GEOPAK Road Module from the Applications menu in MicroStation as shown below: 

 

GEOPAK may not be active when MicroStation opens.  If this is the case, the following 
steps will activate GEOPAK. GEOPAK will remain active in subsequent MicroStation 
sessions until manually deactivated, or if the GEOPAK resource files are deleted. 
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 TO OPEN (ACTIVATE) GEOPAK ROAD 
1 . Deactivate GEOPAK, if running by default, by selecting the MicoStation menu 

option:  Applications > GEOPAK > Deactivate GEOPAK. 

  

2 . Activate GEOPAK by selecting the MicroStation menu option:  
3 . Applications > GEOPAK > Activate GEOPAK.  

 

4 . The Road toolbox allows access to associated GEOPAK tools.  To activate this 
toolbox, click the Applications > GEOPAK>ROAD > ROAD Tools. 

 

Each button on the Road toolbox has an associated toolbox. By clicking the small arrows 
located in the lower right corner of the buttons, a dropdown selection menu opens 
including an option to “Open as Toolbox”. These toolboxes are dock-able and resizable.  
The exercises to follow describe each of these toolboxes. 
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PROJECT MANAGER  
Project Manager is like a project filing cabinet for storage of project specific design 
standards. It organizes and records information for each specific design project, such as 
the project’s user preferences, job number, working alignment, design files, coordinate 
geometry (COGO) information, DTM, and various other files as needed for the project. 
Location of the Project Manager files, defined by each site, should reside under the 
project directory structure in the appropriate discipline folder.  

All disciplines use the information stored in the Project Manager Project file; therefore, 
the FDOT project has only one GEOPAK project. There is more discussion on this later 
in the chapter. 

 TO ACCESS PROJECT MANAGER  
From MicroStation, click Applications > GEOPAK>ROAD > Project Manager. 

 

--or--, from the MicroStation Task menu, select the Road Project Manager menu, then 
setup Project Manager     
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--or-- from the Road toolbox, click the Project Manager button. The Project Manager 
opens.   

 

      

 

The Project Manager ‘project file’ ends in the extension .prj. In addition, each Project 
Manager project includes a project folder, projdbs, where the user files and run files are 
stored. Run files contain the information for individual processes such as creating the 
proposed cross sections for the mainline. 

The Projects list display all projects found in the hard-coded directory shown above the 
Filter box and Type list.  

The Directories list allows you to navigate through your folders to find your project 
directory or to set the current working directory location for new projects. 
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PROJECTS MENU 
Creating a GEOPAK project is a multi-step process; the following dialog boxes describe 
the process. From the Project Manager dialog box creates a new project or allows a 
selection of an existing project to open.   

 

New Create a New GEOPAK Project 

 

Project Name The name of .prj file. The name should contain only 
alphanumeric characters, dashes and underbars. No other 
characters or spaces allowed. (FDOT recommends use of the 
project FPID number.) 

Working Directory Stores the GEOPAK project. An MDL program handles this 
location; do not type a location. 

Job Number The job number defines the Project’s COGO database, also 
known as the .gpk file. If you are creating the .gpk file, enter 
up to three alphanumeric characters in this box. To select an 
existing .gpk file, click on the Select button then highlight the 
.gpk file and click on OK. 

Preferences Opens GEOPAK User Preferences.   
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Edit  The Edit command allows editing any of the settings of an existing 
GEOPAK Project with the exception of the Project Name through Project 
Info Edit dialog box.  The only difference between Project Info Edit and 
New Project is that Project Name is not an editable field. 

 

 

Delete  The Delete command allows deletion of the selected GEOPAK project. 
An Alert dialog displays when selected.  Selecting Yes deletes the selected 
project. Selecting No closes the Alert without deleting the project. 
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DIRECTORY MENU 
There are two options under this menu, Create New Directory and Current Working 
Directory. 

 

Create New Directory This tool creates a new directory under the current 
directory using Make Directory.  The preferred method for creating 
directories is using the Electronic Delivery software, because the process 
automatically creates the eng_data folder. 

 

Current Working Directory  If selected, the Directories path in Project 
Manager is set to the directory in which the active design file is located. 
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ADMIN MENU 
The Admin menu contains the tool to create a password for the project. 

 

 TO CREATE A PASSWORD 
FDOT does not recommend using of Passwords in this option. 

1 . Click Admin > Password, Administration Password opens.   

2 . From Administration Password, type a password and confirm(ation) of the 
password.    

 

3 . Click the OK button. 
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PREFERENCES 
The User Preferences allows for setting project parameters. GEOPAK provides 
numerous user definable parameters allowing the defining of number of decimal places 
for output files, station formatting, coordinate format, units, etc.  These parameters are 
utilized not only by coordinate geometry, but by many of the other GEOPAK functions, 
such as plan view and cross section labeling, DP Station Offset, Design & Computation 
Manager, etc.  The parameters can be set, when accessing GEOPAK, for the most 
commonly used options GEOPAK remembers.  However, the GEOPAK User 
Preferences shown below allows for changes, when a particular application requires a 
change, or the default settings needs changed. 

 TO OPEN PREFERENCES 
If creating a new project, click the Preferences button on Create New Project dialog, --
or-- if opening User Preferences after creating the project, click Applications > 
ROAD > User Preferences.  The GEOPAK User Preferences opens. 
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Unit System Determines whether GEOPAK operates according to the English or Metric 
system of measurement. The Unit parameter affects every GEOPAK 
component. 

Coordinates Sets NE (Northing/Easting) or XY coordinate values in Coordinate 
Geometry. 

Direction Sets the direction format for such variables as line direction in Coordinate 
Geometry. 

Station  Sets the format for station variables in Coordinate Geometry and station 
labeling.  

Output Accuracy 

 Distance  The setting of the decimal places only affects rounding of 
the screen output. Internally, GEOPAK still computes to double precision 
accuracy. 

 Station  The setting of the decimal places only affects rounding of 
the screen output. Internally, GEOPAK still computes to double precision 
accuracy. 

 Angle Seconds The setting of the decimal places only affects rounding of 
the screen output. Internally, GEOPAK still computes to double precision 
accuracy. 

Working Directory This sets the directory where the GEOPAK project exists. An 
MDL application handles this directory selection. Users should not set the 
Working Directory unless the project only involves one discipline. 

Feature Preferences Opens Feature Preferences, utilized when visualizing COGO 
elements and mapping survey data with assigned features.  See more detail 
later in Section 2.3.2. 

COGO Preferences Opens COGO Preferences, utilized for setting the .gpk file 
location, COGO Input File and COGO Output file directories. 
Redefinition of Elements has an on/off toggle options and to automatically 
force redefinition off when COGO is activated are available. It also allows 
modifications of handled the opening, creating or appending of .gpk files. 
See more detail later in Section 2.3.3. 

Show this dialog at GEOPAK startup  When using Project Manager, you do not 
need to select this check box. However, if Project Manager is not used, it 
would be a good idea to select to show the preferences at startup 
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FEATURE PREFERENCES 
Click the Feature Preferences button from the GEOPAK User Preferences dialog box. 
The Feature Preferences dialog will open. This dialog box allows the path to the 
Survey Manager Database (SMD) to be set. Visualizing coordinate geometry elements 
and mapping survey data assigns features into a design file utilize the SMD file. The 
feature code of the element as defined in the selected SMD file determines the symbology 
for the drawn elements.  

FDOT delivers some standard Survey Manager Databases with the FDOT CADD 
software (fdot2010rdwy.smd and fdot2010.smd); located in the 
FDOT2010\GEOPAK\databases directory. The Survey discipline primarily uses the 
fdot2010.smd file to generate the topographics for the project, while the Roadway 
discipline uses the fdot2010rdwy.smd. 

 

Feature Database Directory path and file name of the SMD file. 

Select SMD File Browse to SMD location to select file. 

Edit SMD File Access the SMD file for editing purposes. 

Apply Best Match Feature When selected, the process uses the best match feature 
from the feature SMD to allow placement of one feature in the database 
per item and locates derivatives of that feature from the field survey. 
Example:  Assume that feature EP is the Edge of Pavement, but three 
different EP chains need to be located in the field. They can be located as 
EP1, EP2 and EP3. The mapping process matches these features to the 
Edge of Pavement feature EP in the database. Therefore, no need to define 
multiple EP features in the database. 

Use Shared Cells Allows the use of shared cells when placing cells.  FDOT does not 
recommend use of this option. 

Plot Scale Defines a global scale utilized for drawing graphics into MicroStation. 
The roadway designer communicates the scale of the plan sheets to the 
surveyor to create the topo file from the SMD file with the cells and text 
set to the appropriate scale. 
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Point Label Redraw Options used to define how COGO will draw/redraw points.  
Position by SMD Settings uses the parameters set in the SMD file, and 
Position Relative to Symbol uses the same format as found in the 
MicroStation file relative to the point position. 

COGO PREFERENCES 

 

Job (GPK) Open Mode Determines the file creation constraints imposed on 
creating new COGO database files if the named gpk file does not exist. 
There are three options: 

Create  Automatically creates a new COGO database file. 

No Create  Prevents creation of a new COGO database and displays a warning. 

Query  Queried to create a COGO database if specified database not found. 

Job (GPK) Directory  Location of the .gpk file, if not located in the current working 
directory. Example, if the .gpk file is in the Roadway folder and the 
working is in the Signing folder and needs to reference information in the 
.gpk, then the roadway folder will need to be set as the Job (GPK) 
Directory in order to access the information. Use the key-in ...\Roadway 
in the field so the entire path is not hard coded. 

COGO Input File Directory Location of the GEOPAK input files. If left blank, 
GEOPAK searches for the files in the current working directory or the 
directory of the active file. However if they are stored in a directory other 
than the current working directory or the active file directory, use the 
select button and browse to the directory where they reside. 

COGO Output File Directory Location of output files created in COGO. If left blank, 
the files a saved in the current working directory. 
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Redefinition of Elements Checking the box allows the redefinition or the over 
writing of existing elements in COGO. If not checked, an alert message 
will appear stating the element exists and cannot be re-defined. Leave this 
box cleared from within this dialog box. 

Force Redefinition Off Upon COGO Activation Selecting the check box 
automatically turns off redefinition of elements, when starting COGO. 

 

Exercise 2.1 Accessing GEOPAK and Creating a Project 
In this exercise, the user creates a GEOPAK project. To access GEOPAK and create a 
project 

1 . Extract the project files by double-clicking on the file C:\Chapter2_Ex2_1.exe. 

2 . Open Dsgnrd01.dgn located in C:\e\projects\96385275201\roadway and activate 
GEOPAK CIVIL Suite. 

3 . From MicroStation, click Applications > ROAD > ROAD Tools. Road toolbox 
opens.   

 

4 . From the Road toolbox, click the Project Manager button. The 
Road toolbox is dockable to give more screen space. 

 

<OR> From the Task Menu 
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5 . From Project Manager, click Directory > Current Working Directory.  The 
GEOPAK directory is set to the  C:\E\Projects\96385275201\roadway\ folder.   

 

6 . From Project Manager, click Projects > New. Create New Project opens.   

 

  

7 . On Create New Project, type 96385275201 in the Project Name box. 

Important:   Do not fill in the Working Directory.  An MDL program delivered with the FDOT 
workspace handles this entry. 

8 . On Create New Project, in the Job Number box, type 527. 
Note If the GPK file already exists, clicking the Select button will pop up a list box to select the .gpk 

file.  The list of .gpk files is from the current working directory, if defined, or, if not defined, the 
list of .gpk file is from the active design file directory. 
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9 . Under Project Description, type a brief description or summary of the roadway 
project. 

10 .On Create New Project, click the Preferences button. User Preferences opens.   

11 .On User Preferences, set all parameters as shown below. 

 

Note These preferences can be changed at any time during the course of the project. 

12 .From User Preferences, click the Features Preferences button. Feature 
Preferences opens.   

13 .From Feature Preferences, click the Select SMD file  button to navigate to   
C:\FDOT2010\geopak\databases\fdot2010rdwy.smd for the SMD File. 

  

14 .Select the Apply Best Match Feature check box. 

15 .In the Plot Scale box, type 50.0. 

16 .Click the OK button to save settings and close Feature Preferences. 
Note It is not necessary to set any of the COGO Preferences. 

17 .From User Preferences, click the OK button. 

18 .From Create New Project, click the OK button. Alert opens. 
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19 .From Alert, click the Yes button. Project Manager opens. 

  

Note Alert indicates that the Job Number or GPK number does not exist. Clicking the Yes 
button creates the GPK. 

 

Note At this point in the process, GEOPAK has created a new sub-folder under the 
Project\96385275201\Roadway folder called projdbs and a project file called 
96385275201.prj in the 96385275201\Roadway folder.  
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PROJECT USER  
Upon creating a GEOPAK project (96385275201.prj), one must establish users to access 
project through the Road Project dialog box. A user is a person assigned to work on the 
project.  In most cases, there is more than one user on a project.   

 TO ACCESS THE PROJECT USER DIALOG BOX 
Double click on the Project listed in the Projects window in Project Manager.  The 
Project Users dialog box opens. 

  

Project Users  Displays any users created to work on this project. 

User Info  Displays the full name and Operator Code of the selected user. 

Description  Displays the description of the selected user, usually their title and 
department. 

Users Menu  Offers the options:  New, Edit, Delete, Password and Exit. 
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New  Create a new user with 4 user inputs:  

  

o Name

o 

   Your first name 

Full Name

o 

  Your first and last name 

OP Code

o 

   Operator Code, usually your initials 

Description

Edit Allows changes to the Full Name, OP Code and Description of the 
currently selected user.  

  Optional field that can be used to enter title and 
department. 

Note User Name is hardcoded when created, as this is also the name of the folder created. User 
Name changes requires the creation of a new User Name. The Run files transfer from the old 
User Name folder to the new User Name, deleting the old upon completion. See more 
information of Run files later in this course. 
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Delete Allows deletion of the currently selected user. The following Alert 
displays. Selecting yes deletes the selected user and all the associated files 
for that user. There are no second chances. 

 

Password  Opens User Password to allow users to create or modify passwords for the 
selected user. FDOT discourages setting a password for the user.  

 

Exit Exits Project Users. 

Exercise 2.2 Creating a New  
User In this exercise, you will create one new user. 

 TO CREATE A NEW USER 
1 . Continuing from the previous exercise, on Project Manager highlight 

96385275201.prj and click the OK button. Project Users opens.  See below. 

 

2 . From Project Users, click Users > New. 
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3 . Enter New User using the example shown below. The Description field is 
optional. 

 

4 . From New User, click the OK button. An Alert dialog opens asking if you wish to 
set a password.   

5 . From Alert, click the No button.  Clicking No completes the New User process. 
The Project Users dialog box displays, listing the User created. 

 

6 . In Project Users, highlight the User Name and then click the OK button. Road 
Project opens.  

 

7 . From Road Project select the menu option File > Close to return to Project 
Manager.  
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ROAD PROJECT DIALOG BOX 

 

As previously stated in this chapter, the Project Manager likens to a project filing 
cabinet. In the past, users would have to document on paper the level symbology used to 
draw cross section pattern lines and the file used. Now, Road Project documents that 
information.   

Road Project buttons liken to a filing cabinet drawer. Inside of the file cabinet drawer, 
there are file folders, represented by the Runs, created to accomplish certain tasks. The 
Run likens to a piece of paper in the file drawer, which has the information needed to 
accomplish the task. The Run is a name assigned to a process within GEOPAK that 
identifies specific information for processing so users can easily review the data utilized 
for a specific function. 

Properly using the Road Project ensures ease in sharing of data between disciplines and 
users. Continuing a project is possible, even in the absence of the primary user, because 
Runs will recall all the files and associated settings used on a project. This lessens the 
chance for error and decreases the need for “tracking down” a user for this vital 
information. 

Road Project also makes the process of creating input files for proposed cross sections, 
earthwork and sheet layout unnecessary. Road Project creates these processes through 
dialog boxes and saves them off to a Run for other users to use. No more having to know 
what criteria file goes with which input file. 
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ROAD PROJECT MENU BAR 
The Road Project menu bar at the top has three menus:   

File   Close closes Road Project and reopens Project Manager. Exit 
completely exits and does not reopen Project Manager.  

Remember  Tells GEOPAK to remember the Project and User of the last project 
opened.  When selecting Project Manager with both items selected, 
Road Project opens automatically. If Project is the only selection, then 
opening Project Manager will display the Project Users dialog. If User 
is the only selection, then opening Project Manager will open to select an 
existing project. The active selections will have a check mark beside them. 
These are very useful for working on one project consistently for a long 
period.  

Options Contains the option to select Auto Sink. Road Project sinks behind the 
working window when selecting a tool from the flow chart. Road Project 
returns to the top when the run is closed.  

 TO CONDENSE ROAD PROJECT 
To condense Road Project, click the button to the right of Job #. To display the full 
dialog box, click the same button again.   

 

WORKING ALIGNMENT 
The concept of a working alignment is to allow the designer to organize a project and to 
have the ability to access project information without having to retype data once entered.  

For example, once the user cuts existing cross sections, that information is stored in the 
working alignment.  The user accesses the proposed cross section or earthwork dialog 
box with the existing ground information already filled in, saving time and the possibility 
of making a mistake entering the data. The process carries this information over to all of 
the GEOPAK tools that use the data. On simple projects, there may only be one working 
alignment, but complex projects may have an unlimited number of working alignments 
defined. 
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Working Alignment Influence Runs  Check box tells GEOPAK to use the defined 
working alignment information in any of the Project Manager Runs and 
GEOPAK tools.  

 

   Road Project has three buttons related to the Working Alignment. 

 

Select   Opens the Select Working 
Alignment dialog to select an 
existing alignment or create a 
new alignment using the Run > 
New menu option.   

 

 

 

 

Define   Opens Working Alignment Definition dialog box  to define the working 
alignment information.  This identifies and interacts between the various 
aspects of the project. Upon creation, the user defines the elements for the 
Plan, Profile and Cross Section Views and subsequently uses them for 
other tasks on the project.  

   As shown in this course, defining the roadway information expedites the 
process of filling in dialog boxes with previously defined information in 
the working alignment. 
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Plan View  The Plan View defines the MicroStation file, dsgnrd01.dgn, where the 
proposed roadway items are drawn and the COGO chain name.  The 
Begin Station and End Station fields populate automatically from the 
selected Chain. 

 

o Pattern   Defines the MicroStation file, rdxsrd01.dgn, where the 
cross-section pattern lines are drawn and the level symbology used to 
find/draw them. Refer to CPCH chapter 13 for standards. There are 
two options when drawing the pattern lines, By Station or By Design 
File. The preferred method is By Design File. Because of the FDOT 
level structure, the Lv Names check box is the only option necessary.  
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o Shapes  Defines the MicroStation file, rdxsrd01.dgn, where the 
Super elevation shapes are drawn. There are two options with this tool, 
By Search Criteria or All in DGN. Either method is acceptable.  

 

Profile View The Profile View defines the MicroStation file, 
dspfrd01.dgn, where the profile is drawn and the names of the Existing 
Profile and Proposed Profile that are stored in COGO. The Begin Station 
and End Station automatically populate from the selected profiles. 

 

o Location Defines the location of the Profile Cell, which is a common 
reference point for all profiles.  Click on the Identify Cell button to 
select an existing GEOPAK Profile Cell to fill in the entire dialog box.  
The Draw Cell at X, Y button places a Profile Cell at the DPX and 
DPY coordinates. 
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Cross Section View Cross Section View defines the MicroStation file, rdxsrd01.dgn, 
where the cross sections are drawn.  The Chain and Stationing fields 
populate automatically if there are existing ground sections drawn in the 
selected file.   

 

o Existing Ground  Defines the level symbology of the existing 
ground elements. The Match, Display, and Reset buttons provide help 
filling in the symbology criteria. The buttons work much like the 
MicroStation match tool - select the options to match and pick the line 
in the MicroStation file. Because of the FDOT level structure, 
selecting only the Lv Names check box is necessary. 

 

o Proposed Finished Grade   Defines the level symbology of the 
proposed roadway cross section elements. Because of the FDOT level 
structure, it is easier to leave this section of the dialog blank. 
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  DTM  Defines the location of the Existing Ground TIN file and Portview 
TIN, allowing a different TIN file for use with Port Viewer along with the 
scale settings for the Port Viewer. The course covers this in more detail 
later. 

   

Port Viewer   Opens a tool that allows users to view the plan, profile, and cross 
section views at the same time. This is a good design review tool to aid the 
designer in comparing plan elements with cross section and profile 
elements. 
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Exercise 2.3 Creating a Working Alignment 
 TO CREATE A WORKING ALIGNMENT 

1 . Continuing from the previous exercise, from Project Manager, select the project, 
96385275201.prj and click OK. 

2 . On the Project Users dialog, select the user, John, and click OK.  Road Project 
opens. 

3 . Click the Select button. Select Working Alignment opens.   

<OR>  from the Task Bar Menus , Select Working Alignment 

 

4 . Click the menu option Run> New.  New Run Name opens.   

Tip: Always create a new Run instead of using the provided Untitled Runs.  The Untitled 
Runs are templates, used to create a new Run, when a Run becomes corrupt. 
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5 . In the Run Name field, type CL40 and enter a brief description of the alignment.    

  

Note In the COGO exercise for storing the proposed alignment, the alignment will be stored with 
the name CL40 in COGO. Naming the working alignment the same name as the 
COGO chain simplifies entries and helps to eliminate confusion. 

6 . Click the OK button. Select Working Alignment opens. 

 

7 . Highlight the newly created Run, CL40, and click the OK button.  Road Projects 
opens.  

8 . In Road Project, the selected Working Alignment Run appears after Working 
Alignment. 

  

9 . Select the Working Alignment Influence Runs check box.   

  



Chapter 2 _______________________________________________ STARTING A GEOPAK PROJECT - Road Project Dialog Box 

2-30 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic  

10 .Click the Define button. Working Alignment Definition opens. 

  

11 .Click Plan View.     

12 .Next to the Design File box, click the Select button. Select Design File opens. 

  

13 .Navigate to dsgnrd01.dgn in the roadway folder as shown above, then double-
click the file --or-- click the file and then click the Open button.   
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14 .In the Design File box, replace the full path to roadway with “..\”, as shown 
below.   
Note The “..” is the project directory path and is stored as a workspace configuration variable 

“_PROJDIR” for the selected PROJECT in Microstation Manager. 

  

15 .Click DTM. 

  

16 .Next to Existing Ground TIN, click the File button. Select TIN File opens. 

17 .Navigate to the Survey folder and double-click the file 40tri01.tin. Select TIN File 
closes. 

18 .Next to Portview TIN, click the File button. Select TIN File opens. 
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19 .Navigate to the Survey folder and double-click the file 40tri01.tin. Select TIN File 
closes. 

  

20 .In the Existing Ground TIN and the Portview TIN boxes, replace the full path to 
survey with “..\” as shown above. 

21 .Keyin the numeric value 1 for the Portview Horizontal Scale: and Portview 
Vertical Scale:. 

22 .Click the OK button. The new settings save to the new Working Alignment. 

23 .On Road Project, click Remember > Project, then Remember > User. 

  

Note This exercise does not define all the options in the Working Alignment Definition. Each new 
project components have their definition set through revisiting the Working Alignment. 

24 .On Road Project, click File > Exit, then close MicroStation. 
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3 COGO & HORIZONTAL 
ALIGNMENTS 

INTRODUCTION TO COGO  
The most important component of any GEOPAK design project is the Coordinate 
Geometry (COGO) database. The Coordinate Geometry database always uses a .gpk 
filename extension. Both GEOPAK Road and GEOPAK Survey use the .gpk file to 
store data. 

The .gpk file is comprised of stored geometric elements such as points (both COGO 
points and Survey points), lines, curves, spirals, chains, parcels, profiles and survey 
chains. The Surveyor creates this database with GEOPAK or by the roadway personnel, 
if the .gpk file does not accompany the survey data for each project. Each project should 
have only one .gpk file placed in a folder that allows read/write access, because the user 
updates data to the .gpk file over the course of the project. 

OPENING COGO 
 TO ACTIVATE COORDINATE GEOMETRY 
From Road toolbox, click the COGO button. 

--or-- from the Road Project dialog, click the Coordinate Geometry button  

--or-- from the MicroStation Task Bar menu options 
--or-- from the MicroStation menu options, click Applications > ROAD > Geometry > 
Coordinate Geometry. Coordinate Geometry opens. 
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Project Name Name displayed on reports generated from COGO.  This entry is optional, 
with a maximum of 60 alphanumeric characters.  If Project Manager is 
active, Project Name automatically defaults to the name of the selected 
project. 

Job  A required identifier coordinate geometry database file with a maximum 
of three alphanumeric characters allowed.  If Project Manager is active, 
Job Number automatically defaults to the selected job number. If the box 
is empty, click the Magnifying Glass to select the desired .gpk file.  The 
list of files to choose from will be the .gpk files located in the current 
working directory unless the file path has been set inside User 
Preferences.   

Operator Code Unique 2-character code which enables multiple users access to the 
database file.  The user’s initials are typically used.  This information is 
not required for single user access, but is highly recommended.   

Subject Description of coordinate geometry work completed in the current session 
of COGO with a maximum of 48 alphanumeric characters and used in the 
header information of output files generated by COGO. This information 
is optional. 

OK  Starts the COGO session using the selected job number.  If none exists, a 
prompt appears to create the .gpk file.  

Cancel  Closes the start up dialog without a COGO session opening. 
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COORDINATE GEOMETRY MENU BAR  
After selecting OK on the previously described COGO start-up dialog, Coordinate 
Geometry opens. The job number and operator code displays in the title bar across the 
top of the Coordinate Geometry dialog box. As shown below, the Job is 527 and the 
Operator is jd. 

 

Coordinate Geometry has three separate display areas: 
• Tool Bar consists of drop-down lists and buttons that are customizable to 

each user’s preference. 

• COGO Key-In field allows typed COGO key-in commands and displays 
commands generated by automated process when clicking on command 
driven icons. 

• Output Display Window displays the audit trail consisting of input 
commands and the results generated by those input commands. Clicking on a 
command line in this window will place the command back in the COGO 
Key-In field to reprocess the command. 
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FILE COMMANDS  
The File commands control the file management of input and output files. 

 

Preferences This menu option contains a group of options to set the display settings for 
COGO.  Dialog opens COGO Preferences dialog box, Redefinition of 
Elements toggle, Visualization, Coordinate Display, and Angle Display. 

Input File Utility This command opens the Input File Utility dialog box that contains 
a group of file utilities that includes the following commands; Load, 
Append, Catalog, Delete, Output, Print Input File, Print Output File, 
and Save.  

    

  Load Opens a dialog box listing all input files in the project directory. Selecting 
a file, then the Apply button clears the buffer and loads (into memory) the 
current contents of a previously stored input file. Once loaded, the COGO 
commands in the input file can be processed (read), edited, modified or 
deleted.  Selecting Allow Commands to be Added adds the COGO 
commands to a previously loaded file. 

  Append For input files only, a new input file is created by appending the contents 
of an existing input file to the end of the currently opened input file; use 
the Save command to store this new file. 
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  Catalog Opens a dialog box listing all saved input files in the specified 
project’s directory for the current operator. No action takes place. 

  Delete  Opens a dialog box listing all saved input files. Selecting a file, 
then the Apply button removes this file from your project directory. This 
only deletes the input file, any COGO elements (points, curves, chains, 
etc.) created by the deleted input file are still in the gpk file. 

  Output  Opens a dialog box allowing the writing of an ASCII GEOPAK 
output file from the current output buffer session to a newly created file 
for review/print. (Example: name527.ojd) 

  Print Input File Sends selected input file to the printer. 

  Print Output File Sends selected output file to the printer. 

  Save Saves only current input command lines in memory, not all the lines in the 
output display box, as a permanent file on disk.  Saves the current audit 
trail to a file, such as Fname527.ijd, where 527 is the current job number 
and jd is the operator code. 

Input File Restore This loads a temporary ASCII file of GEOPAK commands into the 
Output Display Window. The correct file name convention is  
j(###)O(oc).inp.  Where ### is the GEOPAK job number and oc is the 
operator code, the user’s initials. This format is not the means by which to 
save input files.  Files loaded into GEOPAK via the Restore command 
use the Save command to save into the GEOPAK cataloging system. 

Database Utilities Opens the Database Utilities dialog box, which includes tools to 
Validate the .gpk file and/or Clean and Compress the .gpk file. 

Import  Imports horizontal and vertical alignments and points from GPK File, 
ASCII points, SDMS alignments and points, LandXML 1.0 geometry, 
RDS and VDOT PLT formats into the GEOPAK .gpk file. 

Export  Exports ASCII points, SDMS alignments and points, LandXML 1.0 
geometry, and alignments and profiles into formats for use in various data 
collectors. 

Exit  Closes Coordinate Geometry and ends the coordinate geometry session. 
A prompt appears upon exit. Selecting the Yes button saves the audit trail 
to a user-defined file name. (point527.ioc where point is the user-entered 
name, 527 is the gpk name, .i indicates an input file and oc is the operator 
code).  Selecting the No button exits the session without saving an input 
file.  Selecting the Cancel button returns the user to the COGO session.   

Note Regardless if the User elects to save; all items created in the COGO session are saved in the 
.gpk file. 
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EDIT COMMANDS 
The Edit commands control the content of the COGO command Buffer. 

  

Clear  Empties the memory of the current audit trail without saving and 
initializes the line numbers to begin a new sequence of commands.  This 
command does not clear the display window. 

Delete  Deletes input commands in the input buffer by line number (or range of 
line numbers) and re-sequences the line numbers for the remaining 
commands. 

Insert  Adds a command line to the current input buffer before a specified line 
number; subsequent command lines shift down and line numbering is 
automatically re-sequenced. 

Modify  Changes a fragment in a command line. The user performs a Read 
command to process the modified command line. 

Read All The input commands loaded into the buffer are processed. 

Type All Displays the content of the current input file. 

Line Range Allows a portion (line range) of the input file to be displayed (Type) or 
processed (Read). 

Editor  Opens COGO Command Editor, which enables you to edit the current 
input file. 

  



Chapter 3 _____________________________________ COGO & HORIZONTAL ALIGNMENTS - Coordinate Geometry Menu Bar 

3-8 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

ELEMENT COMMANDS 
The majority of the work performed in COGO involves commands in the Element menu. 
Element commands covered in this section include storing, stationing, adding additional 
data, deleting, etc. 

Point Commands 

  

  Utility Opens the Point Utility dialog box where you can Delete, Print, or 
Display any point number based on the current COGO visualization 
settings.  

  Cell Opens a dialog box to attaches a cell to a previously stored point. 

  Copy Copies points or a point range to a new point number or range within the 
same GEOPAK database file. 

  Elevation Assigns an elevation to a previously stored point. 

  Equate  Stores a new point with the same values as a previously stored 
point. There are many different Equate From options to explore with this 
tool. 

  Station  Allows you to specify a station for an existing point. In most cases, 
it is best not to associate a station with a point. 

  Store Enables the storage of points, utilizing either Cartesian coordinates (x, y, z 
or N, E, Z) or Curvilinear (station, offset, elevation). This stores points by 
keying in the coordinates or by selecting a location in the design file. A 
station, elevation, point code, cell, feature, or description can be optionally 
stored with the point. 

  Transformation Transforms one set of points into a new coordinate system. 

  Compare Points to TIN  Utilizing a set of COGO points (with elevations), 
compares the COGO elevation to the TIN elevation and completes 
statistical analysis. 

  Set Elevation From TIN    Utilizing this command, GEOPAK adds or updates 
an elevation to a previously defined point, based on a TIN model. 
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Line Commands 

  

  Utility Opens the Line Utility dialog box listing all stored lines. You can 
Transpose, Delete, Print, or Visualize any selected line. 

  Store The Store Line tool is a dialog that allows you to store a line based on 
one point and a direction or two points. The line name can be 
alphanumeric (but not numeric-alpha) to a maximum of fifteen characters. 

Curve Commands 

  

  Utility Opens the Curve Utility dialog box listing all stored curves. You can 
Reverse, Delete, Print, or Visualize any selected curve.  

  Copy Opens the Copy Curve dialog allowing the copying of a user-selected 
curve to another curve name. 

  Data Opens a dialog allowing the calculation of curve geometry between two 
given points with a user specified radius or degree, displaying values for 
Delta, Degree, Tangent, Length and Radius. This dialog does not store a 
curve, nor does it give information for an existing curve. 

  Segment Defines new curves by dividing a stored curve into segments. 

  Station  Opens the Curve Station dialog allowing the re-stationing of a 
previously stored curve with respect to the PC, PT, or PI station. 
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  Store Allows three different options for storing curves, By Tangents, By End 
Points, and Concentric.   

o By Tangents (command shown below) Defines and stores a circular 
curve using optional directions and curvatures.  

o The Station option assigns a station value to the label PC, PI, or PT. 
Station option unselected assigns the PC a value of 0+00. The top of 
the dialog contains the Curve Name key-in field and the optional 
station label. To utilize the Station option, activate the toggle, key in 
the desired station in the key-in field and establish the location on the 
curve to apply the station via the PC/PI/PT option button.  

o The groups: Back Tangent, Element and Ahead Tangent, support 
various options, providing a myriad of ways to store curves. The 
designer selects the options to apply to each situation. 

    

Spiral Commands FDOT avoids spiral curves, if possible. If a spiral is necessary, 
submit specific justification to the District Design Engineer for 
concurrence prior to proceeding with the alignment. If approved, 
document the spiral curve in the project journal. Refer to PPM, Volume I, 
page 2-15, for more information. This manual does not address Spiral 
tools. 
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Chain Commands 

   

  Utility Opens the Chain Utility dialog box where you can calculate the Area, 
Delete, Print, Describe, or Visualize any chains stored in the .gpk file. 

  Layout Offset Project points onto a chain or compute offset distance and direction 
between two chains at each control point or at user-defined intervals of a 
specified station range. 

  Station  The Station Chain command contiguously re-stations the chain 
from the specified element. The previously stored element can be 
expressed as either a point (e.g., 10), curve (e.g., cur a-1) or spiral (e.g., 
spi a-3). The re-stationing can either progress ahead (AH) to the end of the 
chain, or back (BK) to the beginning of the chain. 

  Station Equation Provides a method for applying a station equation to a 
chain by equating the back station to the ahead station, or equating the 
point of a curve (i.e.: PC, PT) to the station ahead. 

  Store Provides three options for storing a chain in the .gpk file: From 
Elements, Offset Chain and Transition Chain.  (Chain name can be 
between 1-15 alphanumeric characters). Store Chain From Elements 
shown below. 
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Parcel Commands Right of Way primarily uses Parcel commands and not generally 
used in Roadway Design, therefore, this class will not cover the Parcel 
tools. 

Profile Commands Components used to store vertical alignments and to define a series 
of grade lines, each of which intersects at a Vertical Point of Intersection 
(VPI), with or without parabolic vertical curves. The Layout tools generate 
Profiles outside of Coordinate Geometry. The DTM tools, Site Modeler, 
or Draw Profile tool generate existing ground profiles. Therefore, there 
are no dialog tools within COGO for creation of profile.  It does support 
Key-in commands.  

    

  Utility Opens the Profile Utility dialog box where you can Delete or Print any 
profiles stored in the .gpk file. 

  Elevation Provides three options for computing elevations along a selected 
profile: Station, Even Stations, and Increment Stations. 

 

  Offset  Stores a new profile within a specified Station Range at a defined 
vertical offset from the original profile. 

  Restation Creates a new profile with different stationing from a previously 
stored profile. 
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VIEW COMMANDS 
The software supports wide varieties of options to customize the COGO window easily. 
This grants the ability to operate from pull down menus, select which icons (if any) to 
display on the screen, the option to display the COGO key-in command line, etc.  

  

Icons 

 

  Detach This Group   Acts as a toggle to turn the icons toolbar on the 
COGO dialog box on or off.   

  Customize This Group  Enables the ability to choose which buttons appear 
in the tool bar. These can be selected by group, (i.e., file, edit, element, 
etc.) or individually. As one selects the individual tools, the corresponding 
button appears under the Cancel button as shown below.  
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Redefine  Toggles the display of the Redefine box on the tool bar. 

Visualization 

  

  Detach This Group  Acts as a toggle to turn the Visualization icons toolbar on 
the COGO dialog box on or off.  The next section of the menu toggles the 
different icons shown on the toolbar.  Check/Uncheck All Items turn all 
the icons on or off. 

Format  

  

  Detach This Group  Acts as a toggle to turn the Format icons toolbar on the 
COGO dialog box on or off.  The next section of the menu toggles the 
different icons shown on the toolbar.  Check/Uncheck All Items turn all 
the icons on or off. 

COGO Key-In Toggles the display of the COGO Key-in box for entering 
commands in the dialog. 
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Command Output Displays the command output window and controls associated 
options for the window.  Use the Save Content As command to save to a 
text file. Other options include Detach Window, Window Navigation, Text 
Coloring, and Clear. 

  

Error Alert  This activates the audio and visual signals when GEOPAK encounters a 
syntax or operator error. The options activate a Beep and/or Restore 
COGO Window.  If the COGO Output Display window is off, it will only 
display when encountering an error and the Restore COGO Window 
option is active. 
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TOOLS COMMANDS 

 

Navigator Opens Navigator tool to assist in viewing, manipulating, and editing 
coordinate geometry elements. Powerful selection tools support a variety 
of coordinate geometry elements, features, etc.  

 

   The following summarizes Navigator functions.  

o Store new COGO elements 

o Review/modify previously stored COGO elements 

o Delete COGO elements 

o Visualize individual or all COGO elements 

o Describe COGO elements 

o Select groups of elements based on a user definable search criteria for 
further manipulation 
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Inverse Calculates the distance and direction between pairs of points and displays 
the results in the COGO command output window as shown below. 

   

 

Locate  Stores a point or series of points based on a previously stored point. To 
locate a point by distance and bearing, click Tools, point to Locate, and 
then click Traverse. Locate Traverse opens as shown below.  
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Intersect The Intersect commands locates and stores a point(s) by reading and 
processing from previously stored points, curves, lines, spirals and chains, 
all from Intersect Tool, shown in the figure below. The results of the 
Intersect Tool shows where point 64 is located and stored at the 
intersections of points 59, 61 and 62, 63.  

             

Best Fit Based on a series of points, the Best Fit tool determines the best fitting 
line, curve, or alignment using a combination of least squares methods and 
other residual computations.  

Translation and Rotation Translates and rotates the coordinate’s values of geometric 
elements within a coordinate geometry database.  

Map Check Opens Map Check / Store Parcel Tool which stores or edits parcels 
(based on directions, distances, and curve data), and compute closure. 
Parcels can be loaded from the coordinate geometry database or manually 
typed in. Once a parcel is complete, clicking Store Parcel stores or 
updates the parcel in the database. This is a tool used mainly by Right of 
Way. 

Roadway Intersections Opens Roadway Intersections, which uses a wide variety 
of user input to define the intersection of two COGO elements, usually 
chains. The results are the storage of COGO points defining radii points, 
curves, and other control information. 
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Cul-de-sacs Opens Cul-de-Sacs, which stores a variety of cul-de-sacs based on user-
defined inputs.  

  

Redraw Visualized Elements Synchronizes the visualized COGO elements in the 
MicroStation file with the coordinate geometry data by redrawing the 
element utilizing the database information, if the location of a visualized 
element in the design file does not correspond to its coordinates in the 
database. 

Clear Visualized Elements (Temporary)  Clears all temporary visualized elements 
from the MicroStation file. 

Clear Visualized Elements (All) Clears all temporary and permanent visualized 
elements from the MicroStation file. 
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NAVIGATOR 
One of the most useful tools in the GEOPAK Coordinate Geometry software is the 
COGO Navigator. The Navigator is an excellent tool to assist in viewing, manipulating 
and editing coordinate geometry elements. This one tool has a variety of functions as 
summarized below. 

 TO ACCESS NAVIGATOR 
From Coordinate Geometry, click Tools > Navigator --or-- click the Navigator button to 
open Navigator. 
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ELEMENT TYPE 
Selecting the type of element, edited or manipulated, from the Element dropdown list as 
shown below enables the utilization of Navigator. 

 

Upon selection of each element type, the list box displays all specified elements within 
the current coordinate geometry database. For example, if selecting Point,  all of the 
COGO points stored in the .gpk file displays in the list box as shown below. 
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NAVIGATOR TOOLBAR 
Above the Element list, the Navigator toolbar is available for basic element storing and 
manipulation. 

  

  Add Element Invokes the appropriate Store Element dialog box. 

  Delete Element Deletes the selected COGO element and prompts to 
confirm the deletion of the element before executing the command. 

  Edit Element Opens the appropriate Store Element dialog box (based on the 
Element command) and supplies the associated data for selected element. 
After making the desired edits, click the Apply button to complete the 
modification. Redefine must be on to modify any COGO elements. 
Editing profiles does not use this tool. 

  Identify Element Identifies an element by selecting a visualized COGO 
element displayed in MicroStation, that element highlights in the 
Name/Feature display within Navigator. 

  Visualize Element Visualizes any COGO element. If either temporary or 
permanent visualization is not active, an Alert message displays. If 
previously visualized, a second set of elements updates to reflect the 
current data stored within the database. The control points are also visible 
and utilized in subsequent COGO commands. 

  Print/Describe Element Prints the selected element’s data into the COGO 
command output window. 

  Selection Set Tool Used to select COGO elements based on user definable 
search criteria. 
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Each of these buttons within Navigator work in conjunction with the currently selected 
element types. For example, with the element Chain selected, clicking the Add Element 
button opens Store Chain from Elements as shown below. 

 

SELECT COMMANDS 
Users utilize the Select menu individually or with the Selection Set tool. The following 
list explains the commands on the Select menu. 

  

Select All Highlights all elements within the Name / Feature list box regardless of 
their status. For example, if Element is set to Point, Select All 
highlights/selects all of the points in the .gpk. 

Invert Selection Reverses the highlighting. For example, elements previously 
highlighted are now un-highlighted, while those that were not previously 
highlighted are highlighted. 

Clear Selection Removes the entire selection of elements from the selection set. 

Selection Set  Opens Selection Set Tool. 

Fit View (Selection Set) Sizes any selected elements into the MicroStation view 
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TOOLS COMMANDS 
The Tools menu contains a variety of commands, as depicted below.  The tool bar at the 
top of the Navigator represents many of the commands. 

 

Note The Navigator Tool buttons covering the first group of (7) tools are in the previously Navigator 
Tool Bar section. 

Visualize Element Visualizes the selection of highlighted elements, based on the 
associated features. Visualization utilizes the default features, if no 
features are associated with the elements. 

Unvisualize Element Deletes the visualization of the highlighted elements when 
selected. Note the element does not delete from the database and no longer 
visualizes in the design file. 

Visualize All (Points, Lines, Curves, Spirals, Chains, Survey Chains, Parcels, and 
Elements) Click the desired element type from the Visualize All menu to 
visualize all instances of that element type. 

Redraw Visualized Elements Redraws all visualized elements. The command 
uses the database information to redraw the element  if the location of an 
element in the design file does not correspond to its coordinates in the 
database.   

Clear Visualized Elements (Temporary) Deletes all temporary visualized elements, 
but does not delete the elements from the database. 
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Clear Visualized Elements (All) Deletes all temporary and permanently visualized 
elements from the design file, but does not delete the elements from the 
database. 

Settings Enables certain actions and behaviors of the Navigator. 

 

EXPORTING TO LANDXML 
There is now support for LandXML formats through LandXML options added to the 
Tools, including: COGO points, horizontal alignments and vertical alignments.  XML 
stands for eXtensible Markup Language. LandXML is a file type that easily transfers data 
between different brands of Architectural/Engineering software. It allows you to develop 
project data in a format easily exported to LandXML 1.2 Geometry format. Software 
other than that which created the original data understands the LandXML file. 

Note  FDOT now requires the LandXML 1.2 Geometry format.  

 TO EXPORT TO LANDXML1.2 GEOMETRY: 
1 . From Coordinate Geometry, click File > Export > LandXML 1.2 Geometry. 

Export LandXML 1.2 opens.  
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2 . In the Project Name box, type the project name, if it has not appeared 
automatically from the working alignment definition. 

3 . If the Project Name appears automatically, the Description, entered at the time 
Project Manager created the GEOPAK Project (Road Project), will also appear 
automatically.  

4 . In the LandXML File box, type a file name --or-- click the Select LandXML File 
button and select a previously stored file. 

5 . From the Output Mode list, click Create for a new file or Append for a previously 
stored file. 

6 . Select Element Type - Chains or Points. The elements will display in the box to 
the right. 

7 . If selecting Chains for Element Type, select the Export All Chains check box.  

8 . Select the Export Profile(s) check box and select the chain. You will also need to 
highlight, using the Shift or Ctrl buttons, the appropriate profile(s) exported along 
the chain. 

9 . Click the Export button. The XML file is stored in the working directory.  

10 .Close Export LandXML 1.2.  
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MISCELLANEOUS COGO KEY-IN COMMANDS 
The following are undocumented commands, but may be useful. 

•  Key-in: rebuild database  Compresses .gpk file. If you experience 
intermittent problems with the .gpk file, use this command to repair the file 
prior to corruption.  

 

• Key-in:  make input file  Creates ASCII input file for stored COGO 
elements.  

The first example (make input file north527.ijd chain north) is for creating an input 
file of a chain; use this same format for creating an input file for a profile by replacing the 
word chain with profile. This is the process used to create the ASCII geometry files for 
electronic delivery. 
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The second example (make input file backup527.ijd all) makes an input file of all of the 
data in the .gpk file.  

 

Either one of these files could be loaded back into this .gpk file or into a new .gpk if the 
original is determined to have corruption.  

If done to restore corrupted gpk’s, then you should “run” ‘make input file’ on a regular 
basis to lessen the amount of data loss. This file restores points, chains, profiles, etc., 
including the original point descriptions and elevations to reproduce the original contents 
of the .gpk, but it in no way recreates the original input files that created the data in the 
beginning. Be sure and save the original input/audit files to aid in explaining why 
elements were stored in a certain manner.  

Note This method is highly recommended for sharing data from your .gpk with other offices or 
companies. 
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Exercise 3.1 Opening COGO  
In this exercise, COGO opens through Project Manager. 

 TO OPEN COGO 
1 . Extract the project files by double-clicking on the file C:\Chapter3_Ex3_1.exe. 

2 . Open DSGNRD01.dgn in C:\e\projects\96385275201\roadway and activate the 
GEOPAK CIVIL Suite. 

Important: Use the FDOT2010 workspace, by double clicking on the FDOT2010 icon on the 
desktop, and project number 96385275201 to open this file. Refer to Chapter 1 for detailed 
information on starting MicroStation.  

 

3 . Reference the file topord01.dgn from C:\e\projects\96385275201\survey to show 
the location of the project. 

4 . In the Road toolbox, click the Project Manager button. Project Manager 
opens. 

  

Important:   If Remember options are on in Road Project, bypass steps 5 through 6. 
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5 . In the Projects list, open C:\e\projects\96385275201\roadway\96385275201.prj, 
and then click the OK button. Project Users opens. 

  

6 . From Project Users, click John in the Project Users list, and then click the OK 
button. Road Project opens.  
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7 . From Road Project, click the Coordinate Geometry button.  
<OR>  from the Task Bar Menu Alignments tab select COGO 

8 . Coordinate Geometry opens.  The Project Name, Job Number and Operator 
Code information supplies automatically from the project information defined 
when creating the project. 

      

Note When Coordinate Geometry activates from the COGO icon in the Road toolbox or by clicking 
Applications > GEOPAK Road > Geometry > Coordinate Geometry, the following dialog 
displays.  

  

9 . Click OK from this dialog box.   
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Exercise 3.2 Storing a Point  
In this exercise, points are stored using COGO tools. The exercise utilizes these points to 
create the Chain representing the Center Line of Construction in a future exercise. 

 TO STORE POINTS USING COORDINATE GEOMETRY 
1 . In Coordinate Geometry, set Visualization to Permanent Visualization.  

  

2 . Click the Browse button. Select Survey Item opens. 

 

3 . In Select Survey Item …, click the  CLC Centerline of Construction. 
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Tip: Selecting the feature the first time, allows the user to skip the steps that include 
browsing to the SMD for that feature. Clicking the down arrow next to Browse opens 
the window to select the appropriate feature(s). 

 

4 . In Select Survey Item, click the OK button. 
Note Notice in Coordinate Geometry that the feature is set to CLC. Anything done in COGO or 

Graphical COGO visualizes into MicroStation with the CLC features for Level, Color, Weight 
and Style. 

 

5 . From Coordinate Geometry menu, click the menu option Element > Point > 
Store --or-- click the Store Point button. Store Point opens.  
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6 . In the Point Name box, type 1. 

7 . Select the Auto Increment check box.  

8 . In the Northing box, type 1762772.79. 
9 . In the Easting box, type 555921.92. 

10 .Select the Description check box and type in a description as shown below. 

Note The Description allows you to place a brief note describing the use of the point. 

 

11 .Click the Store Point button. The point is stored in COGO and visualized into the 
MicroStation file. The point appears in the command output window in 
Coordinate Geometry. 
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12 .Close the Store Point dialog box. 

13 .From Coordinate Geometry, click the   button. Navigator opens. 

14 .In Navigator, set the Element type to Point and highlight point 1 in the Name list. 

 

15 .In Navigator, click the menu option Select > Fit View (Selection Set). 
MicroStation zooms in around point 1. 

16 .  
Note The point number 1 and point name associated displays below. 

 

17 .Close Navigator and Coordinate Geometry.  Alert will display. 

18 .Do not save the input file. Select No from Alert box. 
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GRAPHICAL COGO INTRODUCTION 
Graphical COGO is a tool that utilizes commands with the look and feel of 
MicroStation, yet maintains the double precision accuracy of traditional COGO 
elements. Points, curves, lines, spirals, chains, and parcels can be stored, modified, or 
deleted.   Key-ins or a click of the mouse manipulate the COGO elements and store them 
directly into the COGO database. Graphical COGO does not read the exclusive 
MicroStation graphics. 

 TO ACCESS GRAPHICAL COGO 
From the Road toolbox, click the Graphical COGO button.  

 

--or— From MicroStation, click Applications > GEOPAK Road > Geometry > 
Graphical Coordinate Geometry. 

 

Note If Road Project is not active; the dialog box to verify the Project Name, Job Number and 
Operator Code will open. 
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The Graphical COGO toolbox is dock-able and resize-able. The toolbox has four tool 
buttons (Store Elements, Modify Elements, Manipulate Elements, and Groups) with the 
option to open additional toolboxes that one can drag, dock, or resize. There is access to 
the tools by selecting from a fly-out menu. 

Graphical COGO utilizes the following default naming convention when storing a new 
database item. These names are only defaults, which means, that you can select any valid 
geometric name in any command.  

• Point   P1 

• Line   L1 

• Curve   C1 

• Spiral   S1 

• Chain   CHN1 

• Parcel   PAR1 

STORE ELEMENTS TOOLBOX  
Storing elements utilizes the visualization parameters set in COGO from the SMD file (as 
defined in user preferences).  Non-active temporary or permanent visualization does not 
allow elements to appear. Set visualization to Temporary Visualization when using this 
tool so the elements will appear on the screen. Permanent Visualization is typically not 
set due to the utilization of the Design & Computation Manager to display the roadway 
elements after they are stored.  When selecting a Store Element command, the Store 
Point dialog box appears to enter data based on the tool selected as shown below. 

  

Important:   Be careful to note the naming convention shown in the dialog of the element to be 
stored. The software will utilize the last used settings for naming convention to display and increment 
sequencing.  
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For example, if the last setting used for the naming convention for a series of points to be 
preceded by PNT (i.e., PNT1, PNT2, PNT3), then activating the Graphical COGO Store 
Point will increment to PNT4. If the intent is to store points with the point number such 
as 1, 2, 3..., then the Id number must be manually entered (i.e. 4). It will then increment 
to point 5.  To go back to PNT, set the Store Point ID to PNT4, store the point, and it will 
increment to PNT5. When changing prefixes for Points, Lines, Curves, etc., the next 
number with that prefix will need to entered first, then those prefixed numbers will 
automatically increment. 

   

  

  Store Point Stores points utilizing either Cartesian coordinates (x, y, z or N, E, 
Z) or Curvilinear (station, offset, elevation). 

  Store Equally Spaced Points Stores a user-defined number of COGO points, on a 
line between two previously defined points or any two data points.  A line 
is not drawn nor stored between the two previously defined points. 

  Locate Point Stores a point based on the distance and direction from a 
previously defined visualized point. 

  Store Line From Existing Points Utilizes two stored points to store a line.   

  Store Line By 2 Points  Utilizes two new points, rather than existing points, 
to store a line.  The command stores the line and the new points, utilizing 
the “next” available point and line names. 
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  Store Tangent Line Stores a line and its two endpoints on a tangent to a curve 
in the coordinate geometry database. 

  Store Curve By 3 Points Stores a circular curve (using arc definition).  The 
stationing is set to 0+00 at the P.C.  The user can enter the Radius 
manually or define dynamically. 

  Store Curve By Center  Stores a circular curve by defining the center point, 
radius, and Delta angle. 

  Store Tangent Curve Constrained Places a curve tangent to the specified curve 
or line. 

  Store Tangent Curve Unconstrained  Places a curve through a specified 
point tangent to the specified curve or line. 

  Store Tangent Spiral  Places and visually modifies spirals based on an 
initial line or curve. FDOT does not recommend the use of spirals. 
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MODIFY ELEMENTS TOOLBOX  
The Modify Elements tools modify GEOPAK elements; they look and work much like 
the MicroStation tools. Redefine must be on in COGO, as these tools modify the 
elements already stored in the .gpk. If Redefine is off, a warning dialog box appears. 

  

  Partial Delete Deletes part of a COGO line or curve, creating two separate 
elements. 

  Extend Plan View Element Extends or shortens any COGO element. 

  Trim Elements  Trims numerous elements to their intersection with another 
element. 

  Intersect Elements Stores a new point by trimming or extending one element 
to its intersection with another element.  Note the two elements remain 
intact. 

  Extend Element to Intersect Extends an element to its intersection with another 
element. 

  Extend Elements to Intersect Extends two elements to the point of intersection. 

  Construct Circular Fillet Stores a circular curve between two elements. 

  Construct Chamfer Stores a line between two elements.  Both the line and two 
new endpoints are stored in coordinate geometry. 

  Cut Element Divides elements into segments. 
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MANIPULATE ELEMENTS TOOLBOX 
Like the Modify Elements tools, some of the Manipulate Element tools require that 
Redefine turned on in COGO. If Redefine is off, a warning dialog box appears. 

  

  Move Plan View Element Moves or copies an element (or elements in a 
selection set). 

  Rotate Plan View Element Rotates the selected element about a user-defined 
point. The Angle may be manually entered and locked, or dynamically 
changing. 

  Copy Parallel  Moves or copies an element parallel. 

  Delete Element  Deletes COGO elements and removes the elements from 
the drawing and coordinate geometry database.  This tool works with a 
MicroStation selection set if present. Caution:  There is no undo for this 
command. 

GROUPS TOOLBOX 

  

  Store Chain Works in the same manner as the MicroStation Automatic Create 
Complex Chain with the additional benefit that the 1chain is 
automatically stored in the COGO database. 

  Store Parcel Stores parcels, takings, easements, and other types of right of way 
features. This tool is very similar to the Store Chain tool with many of the 
same options.  
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Exercise 3.3 Using Graphical COGO 
 TO STORE LINES AND CURVES, AND CREATE A CHAIN 
In this exercise, the user stores GEOPAK lines and Curves starting at point number 1, 
stored in the previous exercise, then create a chain from the stored points, lines and 
curves.  

1 . Extract the project files by double-clicking on the file C:\Chapter3_Ex3_3.exe. 

2 . In MicroStation, open DSGNRD01.dgn in C:\e\projects\96385275201\roadway 
and activate GEOPAK CIVIL Suite.  

3 . Open Project Manager. Road Project opens. 

4 . From Road Project, click the Coordinate Geometry button. Coordinate 
Geometry opens. 

5 . On Coordinate Geometry, set the visualization option to Temporary 
Visualization.  

6 . From the Road toolbox, click the Graphical COGO button. The COGO toolbox 
opens.  

  

7 . From the COGO toolbox, click the Store Line by 2 Points button. Store Line by 
2 Points opens. 

 

 

8 . In the ID box, type L1 if the box is empty. 
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9 . Select the Angle check box and then type N 57 05 27 E in the Angle box. Degree, 
minute, or second characters do not have to placed. 

10 .Select the Length check box and then type 1215.3911 in the Length box. Length 
expressed in Master units, i.e., survey feet, meters, etc. 

 

Note In the next steps, read the commands in the status bar. The commands give you important 
information regarding the placement of elements. 

 

11 .To pick the start point, set the MicroStation snap to Origin, snap to the origin of 
the cross hairs next to the number 1, and click a data point, as shown below. 
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12 .Click a second data point to place the End Point of the line, as shown in the status 
bar. The line is now stored in COGO along with 2 points, point number 2 is 
equated to point 1, because that was the start point. 

 

Important:  When creating the chain, in a later exercise, it will start at point 2, not point 1. 

13 .Coordinate Geometry shows the geometry of the line stored as shown below. The 
line displays in the MicroStation file, because the visualization is set to Temporary 
Visualization. 
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14 .From the COGO toolbox, click the Store Tangent Curve Constrained button. 
Store Curve Constrained opens. 

 

  

15 .In the ID box, type crv1. 

16 .Select the Radius check box, and then type 5662.5800 in the Radius box. The 
Radius expresses in Master units. 

17 .Select the Delta check box, and then type 33 03 25 in the Delta box. Degree, 
minute or seconds characters are not necessary. 

18 .Following the instructions in the status bar, click on the line near the End Point of 
the GEOPAK line just stored. 

 

19 .Click again to accept the line -or- right-click to reset and cancel. 

 

20 .Click on the right side of the GEOPAK line to indicate that the Delta Angle is to 
the right, not left. 
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21 .Click again to complete the curve and set the End Point or PT. The Geometry of 
the curve displays in the Coordinate Geometry command output window as 
shown below. 

 

22 .In MicroStation, zoom to the PT of the curve placed in the previous steps. 

23 .From the COGO toolbox, click the Store Line by 2 Points button. Store Line by 
2 Points opens.  

  

24 .In the Id box, type L2 if the box is empty. 

25 .Select the Angle check box, and then type S 89 51 08 E. 

Important:  The defined angle comes from Ahead Bearing found in the COGO output window.  
Using this angle will make the curve tangent. 

26 .Select the Length check box, and then type 9892.69. 
27 .Following the instructions in the status bar, snap to the end of the curve at the PT. 

28 .Click to complete the command and place the line in COGO. 
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29 .Zoom to the end of the line stored. 

30 .From the COGO toolbox, click the Store Tangent Curve Constrained button. 
Store Curve Constrained opens. 

  

31 .In the Id box, type crv2 if the box is empty. 

32 .Select the Radius check box, and then type 22851.32 in the Radius box. 

33 .Select the Delta check box, and then type 01 15 22 in the Delta box. 

34 .Following the instructions in the status bar, click near the End Point of the 
GEOPAK line stored in the previous steps. 

35 .Click again to accept the line --or-- right-click to reset and cancel. 

36 .Click on the right side of the GEOPAK line to indicate that the Delta Angle is to 
the right, not left. 

37 .Click to complete the curve and set the End Point or PT. 

38 .In MicroStation, zoom to the PT of the curve placed in the previous steps. 

39 .From the COGO toolbox, click the Store Line by 2 Points button. 

 

40 .In the Id box, type L3 if the box is empty. 

41 .Select the Angle check box, and then type S 88 35 46 E in the Angle box. 

42 . Select the Length check box, and then type 4988.72 in the Length box. 

43 .To store the line, snap to the PT of the curve and click a data point. 
Note   At this point, all of the elements needed to create a chain in the next exercise are stored. 

Creating chains in this way makes modifying the individual elements and re-creation of the 
chain easier. 
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Exercise 3.4 Storing a Chain 
In this exercise, the user creates a GEOPAK Chain using Graphical COGO built from the Lines, 
Points and Curves stored in the previous exercise. 

 TO STORE A CHAIN 
1 . Open Navigator from Coordinate Geometry. 

2 . Set the Element to Point. 
3 . In the Name list, select all of the points 1-7.  

Tip: To select all points, pick point 1 and drag down the list to grab them all. The Shift 
and Ctrl keys in conjunction with the left mouse button also works, or click Select All 
from the Select menu. 

 

4 . From Navigator, click Select, and then click Fit View. MicroStation performs a 
fit view around all of the selected elements. 

 

Tip: If it is hard to see the elements in MicroStation, turn the display off for the topord01 
file. 
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5 . From the Graphical COGO toolbox, click the Store Chain button. Store Chain 
opens. 

  

6 . In the Id box, type CL40.  
Note CL40 is the name of the chain as it is stored in COGO. 

7 . In the Begin Station box, type 30+00.  

8 . In the Opposing Element list, click Create.  

9 . In the Max Gap box, type the number 0.01. 
Note  The Max Gap is a tolerance setting. If two endpoints used to create the chain are within this 

tolerance GEOPAK considers them touching. 

 

10 .Following the instructions in the status bar, click the first GEOPAK line (L1) 
stored in an earlier exercise. 

 

11 .Click again to accept the line --or-- right-click to reset and cancel. 

Important:  The 3 large arrows displayed on the screen represent the direction of stationing. Be sure 
the arrows are pointing left to right beyond line L1 before clicking a final time to accept the direction 
of stationing. 

Note Review the commands used to create the chain in the COGO output window. 
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Exercise 3.5 Describing a Chain 
To describe the chain 

1 . From Navigator, set the Element to Chain. 

 

2 . Click the chain CL40. 

3 . Click the Print/Describe Element button. The geometry of the selected chain 
displays in the COGO window. 

  

4 . Using the scroll bar, move up or down to review the geometry. 
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Exercise 3.6 Saving the Input Trail 
In this exercise, the user will save an input trail of the commands used to create the above 
chain. This is not a substitute for the geometry file needed for Electronic Delivery. 

 TO SAVE THE INPUT TRAIL 
1 . From Coordinate Geometry, click File and Input File Utility. Input File Utility 

opens. 

 

2 . Change the Load option to Save. 

3 . In the Name box, type SR40. 

4 . In the Subject box, type CL Chain. 

5 . Click the Apply button. The file sr40527.ijd appears in the working directory. 
Note This has an ASCII file format opened for review with a text editor or with COGO and used to 

re-store some or all of the data that is in it. 
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Exercise 3.7 Saving the Output File 
In this exercise, the user will save an output file or report of the actual geometry of the 
chain. This output file can be printed and submitted to your QC department as part of the 
Plans Quality Control.  

 TO SAVE AN OUTPUT FILE 
1 . From Coordinate Geometry, click Edit and Clear. Coordinate Geometry is 

cleared.  

Important:  Clear the session only after you have saved previous commands in an input file for 
backup purposes. The file must be clear to avoid unnecessary data created in an output file. 

2 . From Navigator, set the Element to Chain. 

 

3 . Click the chain CL40. 

4 . From Navigator, click the Print/Describe Element button. The Chain geometry 
displays in the COGO window. 

5 . From Coordinate Geometry, click File and Input File Utility. Input File Utility 
opens. 

6 . Change the Save option to Output. In the Name box, type CL40. Click the Apply 
button.  
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7 . The file CL40527.ojd appears in the working directory. 

 

 

 

8 . This output file name reflects the chain, making file management easier.  This is an 
ASCII file opened with a text editor and reviewed and/or printed. 
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Exercise 3.8 Creating the ASCII Geometry Input File  
In this exercise, you will create the Engineering Data File required for Electronic 
Delivery. Refer to the CPCH chapter 8 for more details. This file is also a good backup of 
the geometry in case restoration is required for overwritten or deleted data. This is also 
the best way to share data between consultants or other users that need your geometry. 
Copying and e-mailing the .gpk can cause problems. 

 TO CREATE THE ASCII GEOMETRY INPUT FILE 
1 . In the COGO Key-In box, type:  make input file cl40527.inp chain CL40. 

2 . Click the Enter key. The file CL40527.inp appears in the Roadway folder. 

 

Note A text editor will open and allow reviewing of this ASCII file . FDOT requires this file to be 
compliant with the electronic delivery requirements. The designer must create this ASCII 
geometry file for all of the critical data stored in the .gpk to include all horizontal and vertical 
data. 

3 . Close Graphical COGO toolbox. 
4 . Close Coordinate Geometry. 
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Exercise 3.9 Updating the Working Alignment 
Now that a chain is stored, the working alignment needs updating. 

 TO UPDATE THE WORKING ALIGNMENT 
1 . From Road Project, click the Define button. Working Alignment Definition 

opens. 

 

 

2 . From the View listing on the left, click Plan View 
3 . On the right side of the Chain box, click the Select button. Chain Selection opens. 

4 . From Chain Selection, click CL40 then click the OK button. The chain name and 
the station limits appear. 

  

5 . Click the OK button. The data saves into the Working Alignment. 

Tip: Whenever a GEOPAK dialog box provides the opportunity to select a name or item 
with a button, always use the button rather than typing the name. If the file does not 
appear, this indicates that there are issues with the GEOPAK directories that need to 
be resolved. 
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4 DESIGN & COMPUTATION 
MANAGER 

OBJECTIVES 
GEOPAK’s Design & Computation Manager (D&C Manager) performs a variety of 
different operations.     

• D&C Manager calls upon established FDOT CADD standards to plot COGO 
elements into MicroStation or to associate MicroStation graphics with FDOT 
CADD standards. 

• D&C Manager places MicroStation elements recognized by GEOPAK and 
used in quantity calculations. 

• D&C Manager identifies the GEOPAK pay item attribute for MicroStation 
elements previously tagged by the D&C Manager.  

• D&C Manager draws various pavement marking operations. 

• D&C Manager draws shapes used to compute quantities. 

• D&C Manager calculates automated quantities used by Quantity Manager. 

ACCESSING THE D&C MANAGER 
 TO ACCESS D&C MANAGER 
From the Road toolbox, click the  D&C Manager button --or-- from MicroStation, click 
Applications, point to ROAD, then click Design & Computation Manager --or-- from 
Road Project, click the Plan View Design button then click the Design & Computation 
Manager button. D&C Manager opens. 
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D&C MANAGER DIALOG BOX  
D&C Manager uses a hierarchical database, referred to as the .ddb file, to store 
information concerning functional classification and display preferences for each feature 
and item used in a MicroStation file.  

The ECSO is responsible for the development of the FDOT standard GEOPAK  D&C 
Manager databases. The Standard English database is fdot2010.ddb developed to 
comply with the CADD Standards as defined in the 2010 CPCH. Users modify this 
database to address project specific items or to comply with District standards. Users, 
with a customized database, save the database into the project directory under the symb 
folder and change the name of the file to the eleven-digit FPID number .ddb. 

 

D&C MANAGER MENU BAR 
The D&C Manager has four menus.   

File  This menu has options to create a new .ddb file, open an existing .ddb file, 
save a .ddb file, save as, merge .ddb files, compress .ddb files, use a 
password for a .ddb file, and exit D&C Manager. 

Edit  Perform multiple edit functions to the .ddb file.   

Settings Control settings from how items display in MicroStation to computing 
quantities properly. The training course covers these items individually 
later. 

Favorites This menu allows users to store and recall frequently used items.   
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D&C MANAGER OPERATIONAL MODES 
D&C Manager has a toolbar for quick access to different modes. The following 
summarizes the function of each button.  

  

 Switch To Toolbox Mode  D&C Manager is set up to work in two different 
modes, dialog box or toolbox. This button opens the toolbox mode, which 
is resizable and dock-able. To change the display back to the whole dialog 
box, click the Switch to Dialog Mode button at the far right of the 
toolbox.  The Place Influence check box is at the left end of the toolbox. 

 

 Identify Item The Identify Item button sets the D&C Manager item to match an 
existing MicroStation element previously drawn by the D&C Manager 
or elements drawn with Graphical COGO and the SMD file.  If the item 
ID does not match an item in the opened database, a message appears in 
the status bar saying: No matching database item.   

 Display The Display button filters the MicroStation elements in the design file so 
only specific features display. This button expands D&C Manager to 
show a collection bin at the bottom of the dialog used for displaying 
multiple items at one time. To add items to the collection bin, double-click 
the item –or- right click on the item and select Add to Collection. This 
tool also opens a second toolbox with four buttons as seen below. 

 

   The tools from left to right are: 

o Normal Display 

o Highlight Selection 

o Hide Selection 

o Display Only Selection. 
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  Design Plots COGO and MicroStation elements into MicroStation with the 
defined symbology by use of Draw Plan and Profile or in conjunction 
with MicroStation’s element placement commands with Place Influence 
selected. 

 

 Set Sets the symbology of previously drawn MicroStation graphic elements 
in accordance with the parameters of a selected item in the database.  

 

 Compute Tabulates quantities of items placed as Pay Items by use of the 
Design, with Place Influence turned on, or Set mode. Drafting elements 
with QA Input or MicroStation tools disables the ability to run quantities 
on those elements. This tool also expands D&C Manager to show the 
collection bin; this allows processing of multiple pay items at one time. A 
second toolbox opens as shown below.  

 

  Shapes The Shapes button uses plan view MicroStation graphics to place shapes 
required for quantities. This tool opens a second dialog box as shown 
below. 
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 Pavement Marking This mode dynamically provides additional options for 
placing pavement striping and markings. This tool adds four additional 
tools to D&C Manager as shown below. 

 

   The four tools from left to right are: 

o Striping 

o Separation 

o Chevron Diverge 

o Chevron Merge 
Note The  FDOT Traffic Plans Course covers the Pavement Marking tools in detail.   

 

 Preference The Preference button expands the toolbar to include four 
additional buttons to configure D&C Manager. These same tools are 
accessible through the Edit menu –or- right click on item or category. 

 

   The tools from left to right are: 

o Create A New Category 

o Create A New Item 

o Modify Item 

o Review Item 

 

EXPLORING FDOT’S .DDB FILE 
FDOT has created a database file, named fdot2010.ddb, in the directory 
FDOT2010\GEOPAK\databases\.  FDOT set up this database specifically to create 
elements with the correct level symbology according to FDOT CADD Standards.  The 
.ddb file is set up with discipline folders called Categories. Each category has 
subcategories called Items.  
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Categories are the basic component of the hierarchical tree, represented by a folder  
icon and organized by discipline in the fdot2010.ddb database. Categories with a 
description relative to their discipline display below. 

Items are subcategories of Categories represented by one of three icons as shown below. 
The Item icon correlates to the definition of the item. An item can be a drafting item, a 
compute item, a default item or a pavement item. (FDOT does not use pavement items). 
Items contain specific functions related to defined element symbology or quantity 
calculations.  

   Default Icon  These items are used to set drafting standards for MicroStation 
commands or to draw COGO elements without annotation. In some cases, 
this is a 3PC routine. 

  Drafting Standards Icon These items can be used to set drafting standards for 
MicroStation commands or to draw COGO elements with annotation. 

    Calculator Icon  Sets drafting standards for MicroStation commands or to 
draw COGO elements.  A pay item attribute tags the graphics used to 
identify the elements used to calculate plan quantities.   
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DESIGN MODE  
The Design Mode is how users place most, if not all, MicroStation elements. Design 
Mode is the default mode when D&C Manager opens and used for the following 
functions: 

• Set Drafting Standards  This function is for the placement of 
MicroStation elements using MicroStation commands by the Place 
Influence option. 

• Plot COGO Elements  Plots the COGO elements into the design file 
according to the Drafting Standards set by the selected D&C Manager item. 

 

Place Influence Used to override the currently active MicroStation symbology 
settings. The Place Influence check box is located at the left of the dialog 
box. 

   By selecting the Place Influence check box, you can use MicroStation 
commands to place or modify elements utilizing the drafting standards 
established for the currently selected item in the  D&C Manager database.  

   When finished placing the elements, turn off Place Influence. Any 
elements that are drawn or modified with Place Influence activated are set 
to the selected item’s attributes.   

Adhoc Attributes Selecting this check box, along with the Place Influence check 
box, allows the user to add Adhoc Attributes to any new element that is 
drawn. When selected and a MicroStation command is invoked a table 
displays, enabling the user to modify the Adhoc Attribute value for the 
element to be placed. 

New Element Only Selecting this check box sets the symbology for new elements and 
does not change the symbology of modified elements to the selected item 
in D&C Manager. 
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PLOTTING COGO ELEMENTS THAT ARE DEFAULT OR CALCULATE ITEMS 
D&C Manager plots GEOPAK COGO elements into MicroStation with the defined 
element symbology. Items can be plotted from the COGO database using each of the 
different type of items as defined previously; default, compute, and drafting standard. 

The process to plot COGO elements using default and compute items are identical. The 
only difference is the users tag “calculator” items with a pay item attribute allowing the 
D&C Manager to tabulate quantities from the graphics. When using a default or 
compute item to plot a COGO element, no annotation is placed in the design file. For 
example, use a North Arrow  item to set the active MicroStation cell and symbology 
according to FDOT Standards by use of the Place Influence check box. 

 

When launching D&C Manager from Road Project and clicking the Draw COGO 
Element button, no prompt appears to enter the GEOPAK job number. However, if not 
using Project Manager, user must enter the job number to begin. 

Draw COGO Element option plots several COGO elements by selecting the desired 
COGO element from the Element Type menu. The options are: 

 

Points  Places cell at stored point locations. This option is not available and 
grayed out when a cell name is not defined for the selected item. 

Lines   Draw a line through a range of COGO points using the selected D&C 
Manager symbology. When a range of points is typed, all of the points 
connect in numeric order. To draw a line through a series of points in a 
specific order, use / to separate the point numbers. 

Curves, Spirals or Chains The user plots elements from the COGO Database by 
selecting the name from the list. When selecting one of these options in 
Draw, a listing of the Curves, Spirals, or Chains in the COGO database is 
included in the dialog box.  
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PLOTTING COGO ELEMENTS USING DRAFTING STANDARD ITEMS 

D&C Manager database items with the drafting standards icon  set symbology for 
MicroStation commands by selecting the Place Influence check box or plotting COGO 
elements with annotation. The annotation includes curve data, stationing, bearings, 
distances, etc. The majority of the items in the fdot2010.ddb have no configuration to 
plot annotation. Upon selection of a drafting standard item, the Place Influence dialog 
box appears.  Click on Draw Plan & Profile to open Draw Plan & Profile.   

Note After invoking this tool, double clicking on any other Drafting Standards item will open Draw 
Plan & Profile for the duration of the D&C Manager session. 

  

  

Note Draw Plan & Profile will turn Place Influence off. 
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At the top of Draw Plan & Profile is the option drop down to select the Element Type. 
The options available from the menu are dependent on the defined settings for the 
specific item in the database. Above Element Type is the currently selected D&C 
Manager feature. The rest of the dialog box displays the various options for the selected 
Element Type. 

  

The following Element Type options are available. 

• Points 

• Lines 

• Curves 

• Spirals 

• Chains 

• Stationing 

• Parcels 

• Profiles 



Chapter 4 ____________________________________________________ DESIGN & COMPUTATION MANAGER - Design Mode 

 

4-12 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

The list box displays the available chains in the selected COGO database on the left hand 
side of Draw Plan & Profile. The right side of Draw Plan & Profile contains a list of 
options for plotting the currently selected item. The D&C Manager database, 
fdot2010.ddb, already has the Curve Label and the Curve Data check boxes selected. 
Select other options as needed. With all options cleared, chain elements are plotted 
without any labels. 

PLOTTING COGO CHAINS 

  

The Label Scale specifies the plotting scale for the text labels. The D&C Manager does 
not set the Label Scale. The GEOPAK default value is 100. 

 TO PLOT A COGO CHAIN 
1 . In Draw Plan & Profile, click Chains from the Element Type drop down. 
2 . Under Select Chain, click the name of the chain from the list box on the left. The 

chain will plot with the symbology of the selected D&C Manager item. 

Important:  Selecting the Chain name more than once will result in duplicate graphics plotting in the 
MicroStation file. 

The curve data text places as a Graphic Group, easily moved as a group with the 
MicroStation Graphic Group lock turned on. 
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Plotting Stationing for COGO chains uses the  D&C Manager database.  

PLOTTING STATIONING ON THE CHAIN 

FDOT Standards has three levels in the MicroStation level library for Stationing and 
Tick Marks.  To plot more than one scale, it is the intent of the FDOT Standards to create 
a separate model for each scale needed. Each model should contain the chain and 
stationing for the desired scale to reduce the number of reference attachments. 

The list of available COGO chains displays on the left side of Draw Plan & Profile. The 
right side contains the options for plotting the stationing. 

  

By default, the D&C Manager database, fdot2010.ddb, has the Tick Marks, Tick 
Marks Stations and PI Labels check boxes already selected.  

The Label Scale specifies the plotting scale for the stationing text.  

 TO PLOT THE STATIONING  
Under Select Chain to Draw, click the name of the chain. The stationing plots with the 
symbology of the currently selected D&C Manager item.  

Important:  Clicking the chain name more than once will result in duplicate graphics plotting in the 
MicroStation file.  
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Exercise 4.1 Plotting & Stationing the Horizontal Alignment or Chain 
In this exercise, the user creates an alignment file and draws the alignment chain, station 
ticks and text of the previously stored chain. 

 TO STATION THE HORIZONTAL ALIGNMENT 
1 . Extract the project files by double-clicking on the file C:\Chapter4_Ex4_1.exe. 

2 . Open DSGNRD01.dgn in C:\e\projects\96385275201\roadway and activate the 
GEOPAK CIVIL Suite. 

3 . From the FDOT Menu, open Create/Edit File by clicking on Roadway >  
Create/Edit File.   

  

4 . Click Create to create the file, ALGNRD01.dgn.  Click Open DGN. 
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5 . ALGNRD01.DGN opens.  Set/Update Plot Scale opens. Use the default settings 
and click OK. 

  

6 . Click OK to close the Create File/Project dialog. 

7 . In MicroStation, open  the Model dialog box.  Create  a new model, 
ALGNRD_50, using information shown below and select OK to open. 
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8 . From Road Project, click the Plan View Design button. Plan View Design 
toolbox opens. 

    

9 . From the Task Menu OR Plan View Design toolbox, click the Design & 
Computation Manager button.  D&C Manager opens.  Navigate to Roadway 
Design>Plan Features>CL Centerline of Construction (with stationing). 
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10 .Click the Draw Plan & Profile button from the Work Mode dialog box. Draw 
Plan & Profile opens. 

 

11 .From Draw Plan & Profile, set the Element Type to Chains. Set the Label Scale to 
50.  

 

12 .Under Select Chain to Draw, click on CL40.  The chain will then plot. 

Important:  Click CL40 only once to eliminate placing duplicates.   
Note To check for and delete duplicates select from MicroStation Utilities>Data Cleanup. Design 

File Cleanup dialog opens .  
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13 .From Draw Plan & Profile, set the Element Type to Stationing.  

 

14 .Under Select Chain to Draw, click CL40. 

Important:  Click CL40 only once. 

15 .Zoom in on the beginning of the chain. The chain, stationing and tick marks 
display.  

  

16 .Close Draw Plan & Profile and close MicroStation. 
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ADHOC ATTRIBUTES  
The GEOPAK proposed cross section criteria looks for elements contained in the design 
files to determine what cross section elements to draw. It also gathers adhoc attribute 
values attached to those elements found in the plan view to define how it is to draw those 
elements/features in cross section view. When elements are not present in the design 
files, then the criteria does not draw those elements into cross section view. This makes it 
very important to use the Design & Computation (D&C) Manager. It has been designed 
to set the correct symbology for the many design files used with the FDOT software. 
Therefore, the criteria look for the design elements based on the D&C Manager items 
(often referred to as ddb features). Along with the attribute tags the D&C Manager 
places, it also places pre-defined adhoc attributes on the necessary elements for the 
criteria to read and use accordingly.  

Adhoc attributes are comprised of three types of information that require definition:  
Name, Type, and Value.  The Name is an identifying term used when GEOPAK is 
searching for a specific Adhoc Attribute.  The Type identifies the nature of the 
information, and set to various options: String, Numeric, Unit, Remarks, and Quantity. 
The Value is the actual information used by GEOPAK, and is determined by the Type.  

For example, if the Type has a setting of Numeric then the Value must be a number.  
The Lock option, used when defining the Adhocs, determines if the Default Value of the 
Adhoc is modifiable when placing or setting the element. 

D&C Manager sets the Adhoc attributes of elements placed in the file by MicroStation 
commands or drawn with Graphical COGO as shown in the previous chapter. Criteria 
read these attributes to correctly draw elements into cross sections or calculate the 
quantities. For example, traffic separators have various options as to how they are 
constructed. Users assign Adhoc attributes to these Plan view elements to ensure 
compliancy to the Standard Indexes. 
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Exercise 4.2 Drawing Plan Elements with Adhoc Attributes 
In this exercise, the user draws the edges of pavement using the D&C Manager to attach 
the Adhoc Attribute.  There are two typical sections for this project with transitioning in 
between.  The first typical section from Station 30+00 to Station 90+00 is a 4 lane 
divided rural section with a 48-foot median.  The second typical section from station 
101+00 to Station 228+00 is a 5 lane undivided urban section. 

 TO DRAW EDGE OF PAVEMENT WITH ADHOC ATTRIBUTES 
1 . Extract the project files by double-clicking on the file C:\Chapter4_Ex4_2.exe. 
2 . Open DSGNRD01.dgn in C:\e\projects\96385275201\roadway and activate the 

GEOPAK Road Project.  
3 . Open the D&C Manager.  Navigate to Roadway Design > Plan Features > EOP 

Edge of Pavement (Concrete or Asphalt). 

 

4 . Click the check boxes for Place Influence, Adhoc Attributes, and New Element 
Only.  EOP Edge of Pavement (Concrete or Asphalt) opens. 
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5 . Zoom into the beginning of the project.  

6 . Using the MicroStation Copy Parallel command, copy the centerline of 
construction 24’ to the right.  (This will be the left side of the right shape cluster, 
therefore the Widen_Side Adhoc value will remain set to the value ‘left’.) With 
copy parallel active, click on the centerline then data point to the right of the 
centerline. 

 

7 . Change the value of the Widen_Side Adhoc to right.  Then data point again to the 
right to copy the EOP line another 24’ to right.  Right click to exit the Copy 
Parallel command. 

8 . Repeat steps 6 and 7 to copy the centerline to left for the left shape cluster.  Make 
sure the Widen_Side Adhoc value is set to the appropriate value. 
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9 . Repeat steps 6 – 8 to continue the edge of pavement through the curve to the next 

tangent section to Station 90+00.  Again, pay attention the left and right values of 
the Widen_Side Adhoc value. 

10 .Use the MicroStation Trim to Element command, select all the EOP edge of 
pavement lines left of the Station 90+00 tick mark, then use the station tick mark at 
Station 90+00 as the cutting element /edge element. 

 

11 .The next section of the exercise you will be drawing the edge of pavement for the 
urban section at the end of the project. 

12 . Move to Station 101+00.   

13 . With the Widen_Side Adhoc value set to left, copy the centerline using the Copy 
Parallel tool. Set the distance to 30’. Click on the centerline and then data point 
to the left of the centerline to indicate direction. 
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14 . Modify the Widen_Side Adhoc value to right. 
15 . Data point to the right side of the centerline.  Right click to exit the command. 

 

16 . Use the MicroStation Trim to Element command, select both the EOP edge of 
pavement lines right of the Station 101+00 tick mark, then use the station tick mark 
at Station 101+00 as the cutting element /edge element. 

17 . Repeat steps 12 through 14 to continue drawing the edge of pavement to the end of 
project at Station 228+00. 

Exercise 4.3 Drawing Edge of Pavement through Transition 
This exercise draws the edge of pavement through the transition area of the project using 
the DP Station Offset tool and D&C Manager. 

 
1 . Extract the project files by double-clicking on the file C:\Chapter4_Ex4_3.exe. 
2 . Open DSGNRD01.dgn in C:\e\projects\96385275201\roadway and activate the 

GEOPAK CIVIL Suite. 
3 . Zoom in to the area of the transition: Station 90+00 to Station 101+00. 

4 . Open the D&C Manager and navigate to Roadway Design > Plan Features > 
EOP Edge of Pavement (Concrete or Asphalt). 
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5 . Turn on Place Influence and Adhoc Attributes. 

 

6 . Select the MicroStation menu option: Applications > ROAD > Plans Preparation 
> DP Station/Offset.  DP Station Offset opens. 

 

7 . Fill out the dialog as shown below. 

 

8 . Set the value for the Widen_Side Adhoc to left.   

9 . Select the MicroStation Place Line tool. Click the DP button on the DP 
Station/Offset dialog. 
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10 .Modify the dialog settings as shown. 

 

11 .Click the DP button on the DP Station/Offset dialog. Right click to cancel the 
place line command. 

12 .Modify the dialog settings as shown. 

 

13 .Set the value for the Widen_Side Adhoc to right.   

14 .Select the MicroStation Place Line tool. Click the DP button on the DP 
Station/Offset dialog. 

15 .Modify the dialog settings as shown. 
 

 

 

 

 

16 .Click the DP button on the DP Station/Offset dialog. Right click to cancel the 
place line command. 

17 .Repeat steps 7 through 16 to draw the transition on the right side of the alignment.  
Remember to use positive offset distances and to set the appropriate value to the 
Widen_Side Adhoc. 
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Exercise 4.4 Checking Adhoc Attributes 
1 . From MicroStation, click Applications > GEOPAK > Road > 3pc Adhoc 

Attribute Manager. Adhoc Attribute Manager opens. 

2 . From Adhoc Attribute Manager, click the 
Identify Element button. 

 

 

 

3 . In the drawing, click the Edge of Pavement 
line previously drawn. 

 

 

4 . Click to accept. In Adhoc Attribute 
Manager, review the Adhoc attributes 
attached to the Edge of Pavement line. 
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DRAW TRANSITION TOOL 
The Draw Transition tool draws elements into plan view using input station and offset 
information. One can use this tool in conjunction with the Place Influence tool in the  
D&C Manager.  
 TO ACCESS THE DRAW TRANSITION TOOL 
From MicroStation, click Applications > ROAD > Plans Preparation > Draw 
Transition  
--or-- from the Road toolbox, click the Draw Transition button  

--or-- from the Plan View Design toolbox, click the Draw Transition button.   

Draw Transition opens. 
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Job and Chain  Contain default information from the working alignment 
definition.  

  Job This is the .gpk file for the project and contains geometry information for 
the project. 

  Chain Reference chain or alignment used to associate the station/offset settings.  

Begin Station Starting Station for the transition. 

Begin Offset Starting offset for the transition.  

Tip: Negative offset distances will draw to the left side of the alignment. 
End Station Ending Station for the transition. 

End Offset Ending offset of the transition. 

Draw button  Draws the transition into the active MicroStation file. 

Begin Station/Offset and End Station/Offset  Populates the dialog information 
from a data point in MicroStation. 

If the Begin Offset and End Offset are the 
same, then the element drawn is parallel to the 
alignment.  Use of the MicroStation Copy 
Parallel tool produces the same results. 

 

Tip:  This is a very useful feature if station 
equations are on the chain to find the 
stations and fill in the boxes with the 
appropriate Region. 
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Exercise 4.5 Drawing Guardrail 
This exercise uses the Draw Transition tool along with  D&C Manager to draw the 
guardrail.  

 TO DRAW GUARDRAIL  
1 . In the drawing, zoom or pan to Station 42+00. 

Tip:   Utilize the DP Station Offset tool in conjunction with MicroStation Zoom In/Out 
commands to move quickly through the project. 

 

2 . Open  D&C Manager. Navigate to Roadway Design >  Plan Features >  
Guardrail >  Guardrail and then double-click item 0536 1 1 Roadway (Left). 
0536 1 1 Roadway (Left) opens. 

3 .  Select the Place Influence check box. 

 

4 . In D&C Manager, select Settings > Design. Design Settings opens.  

5 . On Design Settings, select the Scale Factor check box and type 50. The scale is 
now set for custom styles. Close Design Settings. 

 

6 . From the Plan View Design toolbox, click the Draw Transition button. 
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7 . In GEOPAK Draw Transition, enter the information shown below. 

 

8 . Click the Draw button. The guardrails draw on the left side of the road. 

9 . Close Draw Transition. 
10 .Turn off Place Influence. 

 

Exercise 4.6 Drawing Paved Shoulder 
1 . In the D&C Manager, navigate to Roadway Design > Plan Features > 

PSHLDR. 

 

2 . Turn on Place Influence and Adhoc Attributes. 
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3 . Modify the Adhoc values as shown below. 

 

4 . Zoom to Station 30+00.  Using the MicroStation Move/Copy Parallel tool or 
Draw Transition, copy/draw the outside edge of pavement 5’ to the outside. (Use 
the Move/Copy Parallel tool through the transition section.) 

5 . Continue copying the edge of pavement elements for the outside (left and right) to 
station 101+00. 

6 . Modify the Adhoc values as shown below. 

 

7 . Using the MicroStation Move/Copy Parallel tool, copy the median edge of 
pavement lines 2’ to the inside of the pavement for both sides of the roadway 
median. 

8 . Use the MicroStation Extend Elements to Intersection tool to clean up the paved 
shoulder lines at the end of the transition section. 
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Exercise 4.7 Drawing Curb & Gutter 
1 . In the D&C Manager, navigate to Roadway Design > Plan Features > Curb & 

Gutter, Curb, Gutter > 0520 1 10 Concrete Curb and Gutter (Type F). 

 

2 . With the D&C Manager mode set to  Design Mode, double click on the 
(Type F) curb item.  The Curb and Gutter (C&G) Maker opens. 

 

3 . Verify the dialog settings above, and then click the Draw Curb & Gutter button. 

4 . Click on one of the edges of pavement in the undivided section.  Click again to the 
left or right of the line to designate the side to draw the curb lines. 

5 . Repeat step 4 to draw in the curb & gutter to the end of project. 

 
  



DESIGN & COMPUTATION MANAGER - Draw Transition Tool ______________________________________________ Chapter 4 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT 4-33  

Exercise 4.8 Draw Sidewalk 
1 . In the D&C Manager, navigate to Roadway Design > Plan Features > FSW 

Front of Sidewalk. 

 

2 . Turn on Place Influence. 

 

3 . Zoom in to Station 101+00.  Using the MicroStation Move/Copy Parallel tool, 
copy the back of curb line 3’out, from station 101+00 to the end of the project, 
for both the left and right side of the roadway. 
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4 . In the D&C Manager, navigate to Roadway Design > Plan Features > BSW Back 
of Sidewalk. 

 

5 . Review the Adhocs associated with item. 

6 . Modify the Adhoc values as shown below. 

 

7 . Use the MicroStation Move/Copy Parallel tool to copy the front of sidewalk 5’ 
out from station 101+00 to the end of the project on left and the right side of the 
roadway. 
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DISPLAY MODE 

 

The designer utilizes the Display mode to filter the display and location of MicroStation 
elements in the design file so only specific features display or highlight. This mode 
functions as a check to help the designer verify the correct tagging of elements in a 
design file.  This helps to insure that the D&C Manager finds the elements during 
calculations and running cross sections.  This mode also affects what information is 
printed or computed, if activated when generating plots or quantities.  

 TO ADD THE CURRENTLY SELECTED CATEGORY TO THE COLLECTION BOX 
Click the Add Highlighted to the Collection button. The item or category appears in the 
Collection box at the bottom of  D&C Manager, as shown in the previous figure. 
-- or --  Right click on an item, then click Add to Selection.  

 TO REMOVE AN ITEM OR CATEGORY FROM THE COLLECTION BOX 
In the Collection box, click the item, and then double-click the item. The item will clear 
from the Collection box. 

Tip: Right-click on an item, then click Clear Collection will clear all items from the 
collection box  

  --or--  Click the Clear all items in the Collection button to clear all items. 
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There are four options to filter the MicroStation display:  

• Normal Display  Displays all elements in the file. Display mode only 
recognizes the items that exactly match the symbology settings in the 
database, including the defined attribute. 

  

• Highlight Selection Changes those elements matching items stored in the 
collection area to the MicroStation highlight color.  

  

• Hide Selection Only turns off the display of collection box items and 
leaves all else on. 

  

• Display Only Selection Turns off everything, except the collection box 
items. 
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Exercise 4.9 Checking elements using the Display Mode 
In this exercise, the user checks the elements drawn earlier to make sure they have the 
correct D&C feature. 

 TO CHECK ELEMENTS USING THE DISPLAY MODE 
1 . In the D&C Manager, navigate to Roadway Design > Plan Features > PSHLDR 

Paved Shoulder Line. 

2 . From D&C Manager, click the Display mode button. The D&C Manager 
expands to include the collection bin and the Display toolbox opens. 

3 . From D&C Manager, click the Identify Item mode button. 

  

4 . Click on the PSHLDR Paved Shoulder Line and then click again to accept the 
line. D&C Manager sets to the PSHLDR item. 

5 . From the Display toolbox, click the Highlight Selection button. All of the paved 
shoulder lines in the design file highlight. 

 

6 . In MicroStation, pan along the alignment to ensure selection of all paved shoulder 
elements. 

7 . From the Display toolbox, click the Hide Selection button. All of the paved 
shoulder lines in the design file turn off. 
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8 . From the Display toolbox, click the Display Only Selection button. Everything in 
the design file turns off, except the paved shoulder. 

 

9 . From the Display toolbox, click the Normal Display button. Everything in the 
design file is set back to the way it was prior to using this tool. 

 

10 .From  D&C Manager, click the Identify Item mode button. 
11 .Repeat the previous steps to check the other elements in the design file. 

12 .When finished using the Display toolbox, click the Normal Display button and 
close the toolbox. 

Tip: To check all of the items at one time, add the items to the collection bin and then use 
the display tool. However, if using this method, items can be missed that are drawn 
very close to each other.  
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5 EXISTING GROUND PROFILE 

OBJECTIVES 
• Creation of existing ground profiles from a .tin file 

• Displaying the existing ground profile through the  D&C Manager 
• Creating a profile cell 

• Reviewing the profile in Coordinate Geometry  
• Populate the working alignment 

ACCESSING GROUND PROFILE DIALOG BOX 
The Ground Profile and Draw Profile tools create the existing ground profile. 

 TO ACCESS GROUND PROFILE DIALOG BOX 
From Road Project, click the Existing Ground Profile button. Ground Profile opens. 
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-OR- 

From MicroStation Road Project Manager Tasks 
Menu, click the Existing Features Menu > Existing 
Ground Profile button. Ground Profile opens. 
 

 

 

 

 

 

 

 

GEOPAK generates an existing ground profile based on a stored chain draped across 
either:  a 3D graphic design file or from a .tin file. The profile information is stored in the 
COGO database file and an input file created at the same time. 

Note If accessing the tool from Project Manager, user must create a Run (i.e. EXGROUND).  

 

Profile Name Name of the existing ground profile to be stored in the .gpk.  

Job Number The .gpk file, defaults from the working alignment definition if Project 
Manager is used. 

Operator Typically the operator’s initials, defaults from the working alignment 
definition if the Project Manager is used. 

Chain  Chain used to cut the existing ground to define the PGL. Click the Select 
button to pick the chain name. 

Offset  Distance either right (positive value) or left (negative value) of the Chain 
that to extract a profile. 
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Beg Station Station where the profile is to start.  Place the pointer in the Beg Station 
box and press the Tab or Enter key to populate box automatically. There 
is no requirement to cut profile for the entire length of the chain. 

End Station Station where the profile is to end. Place the pointer in the End Station 
box and press the Tab or Enter key to populate box automatically. 

Extraction methods Found below the End Station.  There are four different types of 
extraction methods: 

   Increment   Creates a profile where there is a specified incremental distance 
between successive VPI points on the existing ground. The first VPI is 
coincident with the begin station.   

  Intersect Creates a profile with VPIs at every PGL intersects of a 
topographic element. The software intersects elements visible in the active 
design file and reference files. Therefore, the MicroStation display must 
be set properly before clicking the Apply button. A 3D triangle file from 
CAiCE uses this method. When using this method, Ground Profile 
changes.  The Radius of output circle controls the size of the circle 
displayed in the design file at every VPI extraction location. 

  Even   Specifies the incremental distance between successive VPI points 
on the existing ground profile. The first VPI point rounds to the next 
highest even station from the Beginning Station. 

  POT   Creates a profile with VPIs at every location where a POT (Point 
Of Tangency) occurs in the referenced chain. 

TIN  The Triangulation file generated by the survey department.  Using Project 
Manager with a supplied .tin file populates this automatically by the 
working alignment definition.  

Apply  Initiates the process of storing an existing ground profile. Upon selection, 
a prompt will appear to confirm the name of the input file, then a window 
appears displaying the station and elevation at every increment point from 
the beginning station to the end station. After extracting the elevations, the 
following prompts will display. 
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DRAW PROFILE TOOL 
Project Manager does not support the Draw Profile tool. The Draw Profile tool 
enables the ability to draw several profiles simultaneously from a variety of data sources.  

 TO ACCESS THE DRAW PROFILE TOOL 
The Draw Profile tool can be accessed two ways. 

1 . From the Road toolbox, click the Draw Profile button. 

 

2 . From MicroStation, click Applications > ROAD > Plans Preparation > Draw 
Profiles. Draw Profile opens. 

 

Important:   A profile cell is required in order to make the majority of the Draw Profiles dialog 
available.  Place the profile cell by any method within GEOPAK prior to drawing profiles. 
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Job Number Identifies the coordinate geometry database, .gpk file, wherein the chain 
for generating the profiles is stored. 

Chain  Chain stored in COGO to cut the profile. 

Profile Cell Control Dialog Opens Profile Cell Control dialog box to the 
current profile cells listing along with associated station, elevation, etc. 

  

   Profile Cell Control is comprised of two main parts: 

  Active Chain  Chain used when generating the selected profile cell. The example 
in the preceding figure shows one profile cell in the current design file that 
is associated to Chain CL40. 
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  MicroStation File, Station   This list box gives information about all the Profile 
Cells that are relative to the Active Chain. Notice in the preceding figure 
that one profile cell is in the Active Design file. The A indicates the cell is 
located in the active file. The Solid circle next to the A indicates which 
profile cell is active profile cell. Figure 5-10 shows a second profile cell 
drawn in a reference file and referenced to the active file. 

  

   Three action buttons are located on the right side of the dialog box. 

    Place Profile Cell – Opens Place Profile Cell which draws a new 
profile cell into the design file. 

 

 Activate Profile Cell – Makes the selected profile cell the active 
cell. 

 Delete Profile Cell – Deletes the selected profile cell from the list 
box. 

 TO CHANGE THE SELECTED PROFILE CELL 
   Double-click on the desired profile cell or click on the Activate Profile 

Cell button. The solid circle moves to the selected cell, DSPFRD02.dgn 
in this example. 
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Update Profile Updates any previously drawn Profile. 

Label Scale Utilized when using the By Feature Display settings option and the text 
setting is set to scale, not fixed.  Compares the specified Label Scale to 
the scale within the Design & Computation Manager Item and 
proportioned. 

 File Commands  

 

   The File commands, Load, Append, Save, and Save As, are used to save 
the dialog settings, load the settings into the dialog, append to an existing 
settings file, or save the settings with another file name. The default file 
extension is .xsd. This file can remember more dialog settings than the 
resource (.rsc) files. All of the information in Draw Profile is lost when 
deleting the .rsc files from the geopak\bin folder. However if a file with all 
of the settings is saved in another location, then that file can be loaded and 
the information is restored. 

Edit Commands 

 

  Cut Rows Cuts a row from the list box into the buffer. The list box is the area 
in the middle of Draw Profile. 

  Copy Rows Copies a row from the list box into the buffer.  Use this command 
if several rows have similar information. Rather than manually entering 
every line into the list box, copy and paste a line, then modified. 

  Paste Rows Pastes a row from the buffer into the list box for subsequent 
editing. 
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Update Options 

 

   Update Options gives GEOPAK direction as to how to handle elements 
already drawn in the file.  Click any Update Option to select the option.  
The check to the left of the option indicates the option is active.  Only one 
option may be active at any given time. Therefore, selecting an option 
clears the previous active option. 

  Delete Existing Elements and Redraw  Selecting this option deletes any 
profiles previously drawn with this tool and new ground lines are drawn. 

  Delete Non-Modified Elements and Redraw  Selecting this option deletes any 
profiles previously drawn, but not manually modified and new ground 
lines are drawn. 

  Draw on Top of Existing  Selecting this option ignores any previously drawn 
profiles and draws a new set, resulting in two profiles. 

  Query  Selecting this option causes a prompt to appear each time a profile is 
drawn or modified.  Update Option opens, as shown below. 
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SURFACES TAB 
The Surfaces tab defines the surface 
utilized for drawing profiles. It is 
possible to draw multiple surfaces 
from a variety of sources in a single 
processing.  Source data includes 
GEOPAK .tin files, Site Models, or 
Site Objects.  There is a requirement to 
add each surface drawn to the list box 
using the action / edit buttons on the 
right side of the tab.  Each surface 
draws a cross section line string or 
lines.  For each line added to the list 
box, the profile is drawn. The 
following describes the buttons along 
the right side of the Surfaces tab. 

 

 

 

 

  Add Surface Settings Places a new Profile Cell 

  Modify Line  Modifies selected Profile 

 Remove Surface Deletes selected Profile 

  Store Surface in COGO Stores selected Profile into COGO. Accesses the 
Store Profile dialog, which stores a profile in the GPK and create the 
Input file used as a backup and for the required ASCII data for Electronic 
Delivery. 
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Details 

 

  Tin File Name of the .tin file used to extract the existing ground elevations. 

  Method There are five methods: 

o Triangles

o 

 Extracts elevations by interpolating triangles. This is the 
recommended method, if selecting a .tin file. 

BreakLines

o POT  Creates a profile with VPIs at every location where a POT 
(Point Of Tangency) occurs in the referenced chain. 

 Extracts elevations by interpolating between break 
lines. This is the recommended method, if utilizing a GEOPAK Site 
component. 

o Increment

o 

  Creates a profile using the incremental distance between 
successive VPI points on the existing ground profile where the first 
VPI point is coincident with the Beginning Station. 

Even

  Display Settings  Specifies the element symbology of the profile elements 
generated.  Specify the symbology by using By Level Symbology or By 
Feature.   

   This method specifies the incremental distance between 
successive VPI points on the existing ground profile, where the first 
VPI point rounds to the next highest even station from the Beginning 
Station.  For example, if the Beginning Station is 10+15 and the Even 
value is 25, the VPIs generates at 10+25, 10+50, etc. 
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o By Level Symbology

 

 Uses GEOPAK Set Feature to set the level 
symbology and is accessed by double clicking the symbology box.  
Right clicking on the symbology box brings up different options to set 
the symbology:  Dialog (brings up the dialog box), By Current (set 
the symbology to the active symbology settings), or By Element (set 
the symbology by clicking on an element in the design file).  Once the 
symbology has been set, options to Copy and Paste the symbology 
settings in other settings un-ghost. 

o By Feature

   

  Allows for the selection of an item from the current  
D&C Manager.  Click the Paintbrush button to open the current  D&C 
Manager where the appropriate item selected. This is the 
recommended method to assure compliancy with CADD standards. 

   

  Filter Tolerances  Consider both Horizontal and Variance Filter Tolerances 
together for each pair of profile segments.  The middle point deletes if 
both segment lengths are less than the Horizontal Filter Tolerance. The 
projected distance, between the mid-point and the chord between the two 
endpoints, is less than the Variance Filter Tolerance. An example of when 
to use Tolerance would be when multiple triangle sides are on top of each 
other. 
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Station Limits 

 

  Offsets  Specifies Vertical or Horizontal Offsets in terms of master units 
(i.e., feet or meters).  The Horizontal Offset is the distance offset from the 
chain.  Once the horizontal location for the profile is determined, the 
profile can be determined by utilizing the data source.  Any Vertical 
Offset applies after generating the profile from the source data. 

 

  Void   The Void Plot Parameters specify the element symbology of the 
existing ground lines generated, which are located within a void in the 
model. With the Void option toggled on, double-click the element 
symbology box and Set Feature opens, where the desired parameters can 
be set. 
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COGO TAB 
Profiles stored in the .gpk, such as a profile with other tools (or via an input file), display 
using the COGO tab, as long as the profile is in COGO. This tool works very much like 
the Draw Plan & Profile tool in  D&C Manager. In the future, this will be the only 
method to display profiles. 

 

Details 

  

  Profile Name  This is a list of the profiles currently stored in the .gpk. 

  Vertical Offset  Defines an offset in which to display the profile. 
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  Station Limits  The Station Limits on the COGO tab are the same as those 
described for the Surfaces tab. 

  Display Settings The Display Settings on the COGO tab are the same as 
those described for the Surfaces tab.   

o Custom Line Style 

    

 This option is available when setting Display 
Settings to By Feature.  Because some items in  D&C Manager use 
custom line styles, this check box applies the correct scale factor as 
they are drawn. 

o Options 

    

 This has many of the same options as those found on Draw 
Plan and Profile within D&C Manager. These options determine the 
information displayed with the profile.  In the preceding figure, 
selecting General allows the Horizontal and Vertical Axis Labels to 
place or Station Equation when selected.  
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PROJECTION TAB  
The Projection tab can be used when the chain / profile to be drawn is different from the 
chain / profile used to create the profile cell.  

There is a requirement to add each projected profile drawn to the list box by using the 
action / edit buttons on the right side of the dialog. Upon adding a line to the list box, the 
profile is drawn. Clicking Draw in the list box deletes or redraws the profile. 

 

Note  This class will not utilize this tool, because there is only one alignment for the project. 
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REVIEWING THE PROFILE 
After creating the profile, review the information in one of two ways: 

• Display the output in Coordinate Geometry. 
• Use D&C Manager or Draw Profile to draw the graphics into a MicroStation 

file for reviewing. 

PROFILE REPORT 
 TO REVIEW THE TEXT REPORT LISTING STATIONS AND ELEVATIONS OF A GROUND 

PROFILE 
1 . Open Coordinate Geometry.  

2 . Start Navigator.  
3 . From Navigator, set the Element to Profile as shown below. 

4 . Click the Print/Describe Element button to generate and display the output in 
Coordinate Geometry. 
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 TO CREATE AN OUTPUT FILE 
1 . From Coordinate Geometry, click File > Input File Utility. Input File Utility 

opens. 

2 . From Input File Utility, select Output from the drop down menu and type a file 
name in the Output File box as shown below.  

3 . Click the Apply button. 

  

4 . From Input File Utility, select Print Output File option. 

 

5 . Select the desired output file name and click the Apply button. The output is 
printed. 
Note Use the default system printer. 
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DRAWING PROFILES WITH D&CMANAGER  
Plot Profiles into MicroStation using the same method as plotting an alignment.  

 TO DRAW PROFILES WITH DESIGN & COMPUTATION MANAGER 
1 . From D&C Manager navigate to the Item established for Existing Ground Profiles 

and click the item.  

2 . Click the D&C Manager Design mode button. EPGL_50_5 50 Scale Horiz., 5 
Scale Vert. opens. 
Note The profile items in the fdot2010.ddb database are set up based on scale, horizontal and 

vertical. 

 

3 . From EPGL_50_5 50 Scale Horiz., 5 Scale Vert., click the Draw Plan & 
Profile button. Draw Plan & Profile opens. 

DRAW PLAN & PROFILE 
By default, when opening Draw Plan & 
Profile, the operation sets Element Type to 
Profiles. The list box on the left side of the 
dialog box shows a list of profiles that are 
stored in the .gpk. Along the right side of the 
dialog box are labeling options for the selected 
profile.  

The selected items are the minimum labels 
required based on the PPM. These settings 
change when selecting a proposed profile item.  
The Horizontal and Vertical Axis Labels plot, 
upon the drawing of the existing ground 
profile, as seen in the preceding figure; 
however, when the proposed profile is drawn, 
the axis labels are not redrawn.  
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VPI Labels Draws a VPI label. 

Horizontal Axis Labels Draws the stations along the bottom of the profile. 

Vertical Axis Labels  Draws the elevation labels along the left edge of the profile.  

V.C. Increment Elevations Draws labels for elevations along each vertical curve at 
even station intervals. 

V.C. Parameters Draws the dimensions and dimension lines on all vertical curves. 

Grade Labels Draws the profile grade approaching and departing from each vertical 
curve.  Based on the setting picked, draws the plus and/or minus sign in 
front of the profile grade. 

K Value and External Length Display the information above (in a crest curve) or 
below the vertical curve length (in a sag vertical curve). No user-defined 
parameters position these labels and are set to on or off. These two labels 
only work with V.C. Parameters also selected. 

Station Equation If selected, the Station Equation label displays. Select one of the 
two options, Gaps or No Gaps, when labeling the equations. When 
selecting the Gaps option, a gap places at each station equation, so the 
next even station is placed on a major grid.  If selecting the No Gaps 
option, the profile draws contiguous. 

VPC/VPT Label  Includes station and elevations at the V.P.C. and V.P.T. 
This setting has no control over the V.P.I. label. 

Stopping Sight Distance Draws the Stopping Sight Distance label for each vertical 
curve. 

Select Profile to Draw When the labeling settings are set, click a profile from the 
list box and Profile opens as shown below. 
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PROFILE 

 

Profile Range  Provides useful profile information used to determine how to plot 
the profile. Minimum Elevation determines where to plot the axis or 
elevations and to reveal bad or erroneous survey shots. Unrealistic 
elevations display below. 

 

Plot Settings  Contains the scale and station information. 
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  Horizontal Scale Sets the scale based on the item selected in D&C Manager.  
There is an option to change Scales manually.  

  Vertical Scale  Sets the scale based on the item selected in D&C Manager.   
There is an option to change Scales manually.   

  Beginning Station Controls the limits of the profile to plot. Place the cursor in 
the box and press the Enter key to fill in the appropriate station --or-- type 
the station. Remember to enter the region if station equations are on the 
selected chain. 

  Ending Station  Controls the limits of the profile to plot. Place the cursor in 
the box and press the Enter key to fill in the appropriate station --or-- type 
the station. Remember to enter the region if station equations are on the 
selected chain.  The syntax specifying regions as  37+00.00 r 2  tells the 
software that Station 37+00.00 is in Region 2 of the specified chain. The 
syntax specifying 30+00.00 tells the software that there is not a station 
equation;  30+00.00 r 1  means the same thing. If unsure where the station 
equations are on the alignment, go into COGO and describe the chain as 
discussed in chapter 3 of this training course. 

  Strip Grade Increment  An elevation label at even stations as specified by the 
user.  Florida projects do not typically use this option. Leave the box blank 
for no labels. 

Profile Reference Point  Contains information 
unique to the profile cell or a 
common reference point used by 
other profiles, like proposed, 
drainage or utilities.  

 

  Reference Station  The Station assigned to the profile cell origin.  

  Reference Elevation  The Elevation assigned to the profile cell origin, a whole 
number value to reflect the major grid. Use a lower elevation than the 
minimum elevation shown in Profile Range at the top of Profile to ensure 
that the profile does not dip into the horizontal axis labels at the bottom of 
the profile.  

Note Do not allow elements to fall below this elevation. The Profile Labeler tool has problems with 
the elevation labels if elements fall below the DP Elevation. 

Example:  If the minimum elevation is 27.39, set the DP Elevation to 25.00. This value is well 
below the lowest elevation, but not low enough to cause the proposed profile to encroach into 
the plan area. When placing the profile cell, these values are considered, as well as special 
ditch and utility profiles, when setting the elevation for the profile cell. 



Chapter 5 _____________________________________________________ EXISTING GROUND PROFILE - /Draw Plan & Profile 

5-22 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

X and Y Sets the location in the MicroStation file where the profile cell origin is 
drawn and, consequently, where the profile is drawn. Type these values --
or-- click the DP button to populate the boxes.  Locate the X and Y, 
somewhere near the coordinates of the Proposed design, to make clipping 
Plan & Profile sheets easier, because both display in the same window. 

Profile Cell   Draws the cell defined earlier and then draws the profile –or—used 
to identify an existing profile cell.  With the location defined and the 
profile cell drawn, user MUST NOT move the profile cell. 

 

  PGL Chain The chain used to cut the profile. The Select button selects the 
chain via a dialog. 

  Draw Cell At XY Draws the profile cell at the defined coordinates. 

  Identify Cell Selects a previously drawn profile cell and populates the top 
portions of the dialog box. 

  OK   Draws the profile at the location of the cell. 

  Cancel  Closes the Profile tool without drawing the profile. 
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Exercise 5.1 Creating Existing Ground Profile 
In this exercise, the user creates an existing ground profile using the Draw Profile tool. 

 TO CREATE AN EXISTING GROUND PROFILE 
1 . Run the executable file C:\Chapter5_Ex5_1.exe to extract the project files for this 

exercise. 

2 . Open the file C:\e\projects\96385275201\roadway\DSGNRD01.dgn using the 
FDOT2010 MicroStation icon. 

3 . Open Create File/Project from the FDOT Menu option Roadway > Create/Edit 
File. 

4 . Select File Type: Proposed Profile and click the Create button to create the file 
DSPFRD01.dgn.  

 

5 . Click the Open DGN button. 

6 . Click OK to set the plot scale of the file. 
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7 . Click OK to close Create File/Project. 
8 . Reference the design file DSGNRD01.dgn and Fit View. 

9 . From the Road toolbox, select the Draw Profiles tool. Draw Profile opens. 

 

10 .Select 527 in the Job Number box, and set the Chain to CL40. 
Note Job 527 is the .gpk database. 

11 .Click the Dialog Profile Cell Control button. Profile Cell Control opens. 

 

12 .On Profile Cell Control, in Active Chain, select CL40. 

13 .Click the Place Profile Cell button on the right side of the dialog box. Place 
Profile Cell opens. 
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14 .In Place Profile Cell, complete the information shown in the preceding figure.  
15 .Click near the Plan View reference file to place the profile cell in the design file. 

Place Profile Cell closes.  
Note Placing the profile cell near the plan view makes clipping the plan and profile sheets easier in 

a later chapter. 

16 .Close Profile Cell Control. 
17 .From MicroStation, click the Fit View button. 

18 .From Draw Profile, select the Surfaces tab.  

Tip:   If the dialog options are not available (grayed out),  click the COGO tab and then 
click the Surfaces tab again.  The dialog options will un-ghost. 

. 
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19 .Under Details, Browse to the TIN File at:   

C:\e\projects\96385275201\survey\40tri01.tin. 

 

20 .Select Triangles as the Method for extraction. 

21 .Set the Display Settings to By Feature. 

22 .Click the paintbrush icon to the right of Feature. Select Design & Computation 
Pay item opens. 

 

 

23 .In Select Design & Computation Pay item, navigate to: Roadway Design > 
Profile Features > Roadway Design Profiles > Profile Grade Line (Existing) > 
EPGL_50b 50 Scale Horiz., 5 Scale Vert.  

 

24 .With EPGL_50b 50 Scale Horiz., 5 Scale Vert highlighted in Select Design & 
Computation Pay item, click the OK button. Feature is set to the selected item’s 
symbology and Select Design & Computation Pay item closes. 

25 .Toggle on the Void check box.  Right-click on the symbology box under Display 
Settings and click Copy.  Right-click on the symbology box next to Void and click 
Paste to set the void symbology. 
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26 .On Draw Profile, click the Add Surface Settings button to add the profile to the 
list and to the design file. 

 

27 .Click the Store Surface in COGO button. Store Profile opens. 
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28 .From Store Profile, enter the information shown in the preceding figure. 
29 .Click the Apply button. The profile is stored in the GPK file. 

30 .Close Store Profile. 
31 .Uncheck the Draw checkbox for EXGROUND in the list box. 

32 .From Draw Profile, click the COGO tab. 

 

33 .Under Profile, select EXGROUND. Enter the information shown in the preceding 
figure. 

34 .Click the Add COGO Profile Settings button on the right side of the list box to 
draw the profile into the MicroStation design file. 

35 .Close Draw Profile. 
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Exercise 5.2 Display Existing Ground Profile In COGO 
In this exercise, the user displays the profile and reviews the information using COGO. 

 TO DISPLAY THE PROFILE IN COGO 
1 . Run the executable file C:\Chapter5_Ex5_2.exe to extract the project files for this 

exercise. 

2 . Open the file C:\e\Projects\96385275201\roadway\DSPFRD01.dgn using the 
FDOT2010 MicroStation icon. 

3 . From Road Project, click the Coordinate Geometry button. Coordinate 
Geometry opens. 

 

4 . In Coordinate Geometry, select the menu option Tools > Navigator. Navigator 
opens. 
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5 . From Navigator, select Profile in the Element list. 
6 . In the Name list, select EXGROUND, and then click the Print/Describe Element 

button. The stations and elevations of each VPI used to store this profile appear in 
the Coordinate Geometry display window. 

 

 

7 . Close Coordinate Geometry.  
8 . Alert opens. Click the No button. 

 

Note The Yes button prompts the user to enter a file name to create an input file of the commands 
used in COGO. 
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Exercise 5.3 Updating the Working Alignment 
In this exercise, the user updates the Working Alignment in Project Manager. 

 TO UPDATE THE WORKING ALIGNMENT 
1 . Open Project Manager. 
2 . From Road Project, click the Define button. Working Alignment Definition 

opens. 

 

3 . From Working Alignment Definition, click Profile View from the category list 
and type the information shown below. 
Note Design File is C:\e\Projects\96385275201\roadway\ DSPFRD01.dgn. 

 

Tip: Click the Select button to help fill in the Existing Profile box. 
4 . From the Category list, select Profile View > Location. 
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5 . Click the Identify Cell button. 

6 . Click the Profile Cell drawn in DSPFRD01.dgn. All of the information required 
appears in Working Alignment Definition. 

Tip: To make selecting the Profile Cell easier, zoom in close to the Profile Cell origin. 
7 . Click the OK button. The Working Alignment Definition updates. 
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6 PLAN VIEW LABELER 

OBJECTIVES 
• Review all the tabs located inside the Plan View Labeler. 
• Place a label with a FDOT style file. 

• Create a new style file and label. 

ACCESSING THE PLAN VIEW LABELER 
 TO ACCESS THE PLAN VIEW LABELER 
Access the Plan View Labeler by: 

• From the Road toolbox, click the Plan View Labeling button --or-- 

• From MicroStation Menu option, click Applications > ROAD > Plans 
Preparation > Plan View Labeling --or-- 

• From Road Project, click the Plan View Design button. The Plan View 
Design toolbox opens.  Click on the Plan View Labeling tool.  
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GEOPAK - PLAN VIEW LABELER OVERVIEW 
The Plan View Labeler automates the composition and placement of plan labels onto 
drawings. Plan View Labeler allows placing “smart labels” on the drawing. These labels 
have the ability to calculate XYZ coordinates, station, offset, direction, length, radius, 
degree of curvature, etc. of the associated element.  

Plan View Labeler, when customized, places many types of standard or non-standard 
labels in the design file.  Plan View Labeler is a very powerful and easy-to-use tool, if 
custom styles are set up properly, which helps to maintain standards and consistency. It 
also allows for user defined frequently used text strings to appear and incorporate into 
labels. 

 

Plan View Labeler synchronizes with the D&C Manager for level symbology, saving 
time and effort as the symbology standards are already set up in D&C Manager. It can 
read geometry from the COGO database (.gpk) or measure lines drawn in MicroStation 
and retrieve the bearing or angle. 

Plan View Labeler is set up to work with label style files (.lsf) provided by FDOT. 
Users can also create custom styles by providing information on the text, parameters, 
shapes, leaders and rotate tabs.  

Note The FDOT2010 Workspace loads the C:\FDOT2010\GEOPAK\bin\Roadway.lsf by default. 
This file is READ-only. 
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The label placed displays in the box on the right side of Plan View Labeler as shown 
below. A user can select the various tabs to define/modify the label appearance. 

 

Space  Places a space in the label at the position of the cursor. 

Return  Places a return to start a new line of text in the label. 

Clear  Clears out the contents of the label to start a new label. 

Delimit Places a line between lines of text. 

Place Label Attaches the label to the pointer for placement in the drawing. 

  



PLAN VIEW LABELER - GEOPAK - Plan View Labeler Overview __________________________________ Chapter 6 

 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT 6-5  

TEXT TAB 
The calculation of a location, like a station/offset or the geometry of a line or curve, 
primarily utilizes the Text Tab options. 

  

Job No. The working alignment definition fills this option from the project .gpk 
file. Use the Select button to browse and pick the .gpk from a list. 

Chain  The alignment utilized for labeling, filled in by the working alignment 
definition. 

TIN File GEOPAK binary TIN file name utilized for Z Elevation in the computed 
text options. Click the File button to open a TIN file dialog box and select 
the specified file. 

Label Feature Four options are available for selection of the type of label for placement. 

   Select or MS Element  Select a MicroStation or GEOPAK element and 
label based upon those parameters. The computed text inserts change to 
reflect labeling options appropriate for the selected element type. 

   Data Point Location Select a data point inside MicroStation and label 
based upon those parameters. The computed text inserts change to reflect 
labeling options appropriate for this element type. 

   2 GPK Point Line  Option to select two visualized GPK points and 
create a label based upon a line between those points. 

   3 GPK Point Arc  Option to select two visualized GEOPAK points 
representing the PC and PT respectively. GEOPAK then prompts for a 
center point, another visualized GEOPAK point or a point on the curve. A 
display curve is drawn and then a prompt for the Chord Direction Point, 
which is identified dynamically. 
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Computed Text Inserts The power of the Plan View Labeler is in the use of 
Computed Text Inserts. Based on the element type being labeled (i.e., 
point or line), there are numerous computed values, which can be included 
in a label. Once added to a label, the inserts values automatically re-
compute for subsequent elements identified   

   Computed Text Inserts is a list of calculated values computed by the Plan 
View Labeler based upon the label feature chosen. Upon choosing the 
label feature, the Computed Inserts change to reflect the feature.  

   Selecting the number in the list at the bottom right corner of Computed 
Text controls the number of decimal places.  Double clicking the list 
option places the computed value in the label text box.  The figures below 
show examples using the Select or MS Element button and selecting 
different element types in MicroStation.  
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User Text Inserts  Assists in populating the labels with frequently used words or 
phrases. An ASCII file created contains the commonly used words and 
used to select from in lieu of typing. FDOT provides a number of 
customized ASCII text files to use with Plan View Labeler, located in 
\FDOT2010\GEOPAK\bin. 

 

  File Manipulation Buttons  Upon selection of User Inserts, the buttons for file 
manipulation display.  The following identifies each function. 
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PARAMS. TAB 
The Params tab sets up the label text preferences and symbology.  

   

Th:  Height  Text height 

Tw:  Width  Text width 

Line Spacing  Line spacing 

Ft:  Font  Font Type 

Note Enter the text parameters at 1:1 as shown above to allow easy use of the custom label with 
any scale.   

 

Automated Set Buttons   Enter the level symbology manually or use one of the four 
buttons located at the bottom of the Plan View Labeler: 

   Set By Current  Populates the Level, Color, and Weight from the 
active level symbology in MicroStation.  

   Set By Element  Populates the Level, Color, and Weight from a 
selected element in MicroStation. 

   D&C Symbology Populates the Level, Color, and Weight from an 
item selected in Design & Computation Manager. 

   Set All Parameters Populates the current tab symbology settings to the 
other tabs, Shape and Leader, with the current settings. This saves having 
to repeat this process on the next two tabs. 
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SHAPE TAB 

   

The Shape tab contains the settings to place a shape around the label and set the 
symbology of that shape. The first option shown sets no shapes to be drawn.  Offset 
defines a margin between the shape and the text. 

LEADER TAB 

   

The Leader tab contains the options to include a leader line and terminator with the text 
label. If no leader line is necessary, click the NO button under Leader Type. A number 
of different leader types and terminators are available. In the preceding figure, the AT 
(Active Terminator) has been selected. Double-click in the picture area to select a custom 
terminator from a cell library. The cells shown in the selection dialog box populate from 
the attached cell library, therefore attaching the correct library is required. Any of these 
options change on the fly, even if the selected style has a certain leader line already set 
up. The symbology options work the same way as in the Params. tab. 
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ROTATE TAB 

 

The Rotate tab selects the orientation for the label based upon the parameters defined in 
the tab.  

 Current Angle Sets the angle at the current angle. 

 Element Angle  Sets the angle based on a selected MicroStation element. 

 Alignment Angle Uses the chain specified in the text tab to rotate the label at 
an angle relative to the chain. Use this option before or during the 
placement of a label.  

Set Angle By  Sets the label angle by selecting two data points in the drawing using the 
(DP) option or picking a MicroStation element with the (Element) option 
or setting the rotation to the current angle with the (AA) option. 
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STYLES TAB 

 

One of the most useful tools of the Plan View Labeler is the ability to store custom 
labels. The combination of computed and text inserts, shapes, leaders, element and text 
parameters of the label can all be stored under a unique name enabling you to create a 
complete library of labels to use in subsequent sessions. The styles are stored in .lsf files. 
FDOT delivers a number of custom .lsf files located in FDOT2010\GEOPAK\bin.  

TIP:    When modifying the standard .lsf files from FDOT, copy the original .lsf file to the 
project Symb folder before making changes. 

The Style Files menu in the Plan View Labeler creates, opens, and saves new style files. 
Each style file employs a hierarchy system to easily and quickly organize and 
subsequently locate the desired label styles. Several supported utilities manage the 
categories, which likened to folder names.  

The following displays the tools available upon 
selection of a category. 

 

 

 

 

The following displays the tools available upon 
selection of a style. 
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PLAN VIEW LABELER MENU BAR 
Plan View Labeler has four menus: 
Style Files Menu to create, open, and save style (.lsf) 

files and exit the Plan View Labeler. 
Previously used .lsf files appear at the 
bottom of the menu.  

 

 

 
Options This menu provides five commands to 

aid in the placement of labels:  

 

  Minimize Dialog  Minimizes the dialog box 
when selecting Place Label. 

  Use Reference File Coordinates  Uses the coordinates from the master plan 
file when placing a label in a plan sheet that has rotated reference files not 
rotated view. 

  Use DP Element Association   Enables the association between 
MicroStation elements and data point labels snapped to the element. If 
using this option to modify the element labeled, the point labels move with 
the element when the label update feature is used. 

  Label Tools  Opens the Plan View Label Control toolbox, as shown below. 
This toolbox contains common tools for placing and modifying labels. 

  

  Label Viewer  Activates Label View and displays a 
preview of the label with the ability to place the 
label from the dialog.  
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Scale   Changes the scale of a label placed and uses the original creation scale to 
scale the label.  For example, a label created with text set to 0.07 at a scale 
of 1.000 draws with text at 3.5 when changing the scale to 50.000. 

   

Tools 

 

  Label Updater  Replaces any label that has been 
previously placed by Plan View Labeler with 
the Use DP Element Association option selected 
and corrects the label to the new contents based 
upon changed information.     

   

  Selection Set Labeling  Allows for placement of 
multiple elements that need labeling in a 
selection set and mass labeled at one time. 

 

  Plan Label Preferences   

   Customizes plan view 
labels. There are options 
for Bearing, Distance, 
Elevation, and Area. 
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Exercise 6.1 Placing a label using FDOT’s style file 
In this exercise, the user places a label created from an existing Library Style File or .lsf, 
library delivered with the FDOT 2010 software. 

 TO PLACE A LABEL USING FDOT’S STYLE FILE 
Perform labeling in the main design file for the discipline for which worked is done, not 
in the sheet files. FDOT also allows text in a separate text design file to use as a reference 
to all appropriate design files. The filename for the text design is Textrd01.dgn, if not 
placing text in the main design file. 

1 . Run the executable file C:\Chapter6_Ex6_1.exe to extract the project files for this 
exercise. 

2 . Open dsgnrd01.dgn in C:\e\projects\96385275201\roadway. 

Important: From MicroStation, attach the Roadway.cel. Select Element > Cells. 
From the Cell Library dialog, select File and then select the Roadway.cel from the 
list. Close the Cell Library dialog.  

3 . Open Road Project. 
4 . From Road Project, click the Plan View Design button. Plan View Design 

toolbox opens. 
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5 . From the Plans View Design toolbox, click the Plan View Labeling button. Plan 
View Labeler - Style opens. The roadway.lsf file is loaded from the workspace.  

 

6 . From the Styles tab, under Item Selector, double-click the FDOT-Labels folder, 
and then double-click the Roadway folder. 

   

7 . Click the Begin Project style, and then click the Select Style Item button. The 
style becomes active. 

 

Note Do not worry about the rotation of the display text in the Style Preview window; you will adjust 
this for each location based on the sheet rotation. 
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8 . In MicroStation, pan or zoom to the beginning of the project, near Station 30+00.  
Rotate the view such that the alignment is horizontal on the screen. 

9 . From the Plan View Labeler menu, select Scale > Change Scale. Scale Style 
opens.  

10 .From Scale Style, type 50 in the New Scale box and click the OK button. 

  

Note Creating this custom label at a 1:1 scale makes it very easy to use on any scale plan. 

11 .From the Text tab, notice the Job No. and the Chain boxes contain default 
information from the Working Alignment. 

 

12 .From the Text tab, click the Data Point Location button. 

 

13 .In the design file, tentative snap and click the point at the beginning of the project, 
Station 32+00. as shown below. 

 

Note The Plan View Labeler places the Remaining Circle and identifies it as the location of the 
data point. 
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14 .On Plan View Labeler, click the Place Label button. Notice the label attached to 
the pointer.  

 

15 .From the Rotate tab, under Set Angle By, click the Element button.  

 

16 .In the drawing, click the Center Line of Construction or Edge of Pavement line. 
The text rotates parallel to that element.  

Important:   Do not snap to an endpoint. 

17 .Move your pointer into the MicroStation view and click to place the label in the 
file. 

18 .To start the leader line, click on the right side in the middle of the text label. 
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19 .To define the length of the leader line, click between the two lines of text on the 
right side of the label as shown below. 

 

Tip: The label displayed above, has the FDOT ArrTermEnd terminator built into it.  
  If the terminator is not correct, attach 

the\FDOT2010\RESOURCES\Cell\Roadway.cel cell library in MicroStation. From 
the Leader tab, double-click the preview window, and then select the ArrTermPrBeg 
terminator. 

20 .From the FDOT Menu, click the Check Design File icon to check the compliancy 
of the file, which should be 100% compliant. 
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Exercise 6.2 Creating a Custom Label 
In this exercise, the user creates a custom label at a scale of 1:1 to label the beginning of 
the guardrail. 

 TO CREATE A CUSTOM LABEL 
1 . Open Explorer and navigate to C:\fdot2010\GEOPAK\bin.  Right click on the 

Roadway.lsf and select copy. 

 

2 . In Explorer, navigate to the project directory, and paste the Roadway.lsf file in the 
C:\e\projects\96385275201\symb directory. 
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3 . Select the Plan View Labeler menu option Style Files > Open. 

 

4 . Navigate to the project directory: C:\e\projects\96385275201\symb, select the 
fdotlabels.lsf file and click Open. 

5 . From the Plan View Labeler Text tab, click the Clear button. This clears the last 
label used. 

 

6 . In MicroStation, pan or zoom to the beginning of the guardrail, near station 
42+00. 

7 . From the Text tab, click the Data Point Location button. 

 

8 . In the design file, snap to the end of the guardrail as shown below.  

 

9 . Click in the label preview box, and type BEGIN GUARDRAIL. 
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10 .Click the Return button. A return appears on the label. 

11 .Type STA. and click the Space button. 

   

12 .In the Computed Text box, select Station and set the number of decimal places to 
two (2).  

 

13 .Double-click Station. The station displays the label preview box. 

  

14 .From the Plan View Labeler menu, select Scale > Change Scale and set the scale 
to 1. 
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15 .From the Params tab, set the parameters as shown below. 

Important:  The Height, Width, and Line Sp. are set to a 1:1 size. Refer to the CPCH chapter 3-4 for 
more detail.  

 

 

16 .From the Params tab, click the D&C Symbology button. Select Design & 
Computation Pay item opens. 
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17 .In Select Design & Computation Pay item, navigate to the Label Standard sheet 
labels item as shown below and click the OK button. The Level, Color and Weight 
for the text are set. 

 

18 .From the Shape tab, click the No Shape button. 

  

19 .From the Leader tab, click the 2-point Leader button, and then click the Active 
Terminator button. Set the rest of the parameters as shown below. 
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20 .In the design file, zoom in very close to the end of the guardrail. 
Note The first label placed is very small, at 1:1. You have to place one label before you can create 

the new style. 

21 .On Plan View Labeler, click the Place Label button. 

  

22 .In the design file, data point the location to place the label. 

23 . On the right side of the label, click again centered between the two lines of text. 

24 . On the left side of the label, click again centered between the two lines of text. 
Label at 1:1 shown below. 

   

25 .From the Styles tab, click the New Style button. Create Style opens.  
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26 .In Create Style, type Begin Guardrail for Style Name as shown below.  

27 .Set the Style Scale to 1.0 and click the OK button.  

 

28 .From the Plan View Labeler menu, select Style Files > Save. The new label will 
save permanently to the attached library. 

  

29 .Delete the 1:1 label placed to build the new style. 

30 .In MicroStation, zoom out twice. 

31 .On Plan View Labeler, click the Clear button to clear the Label Preview window. 

32 .From the Styles tab, select the Begin Guardrail style, and then click the  Select 
Style Item button. 
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33 .From the Plan View Labeler menu, select Scale > Change Scale. Scale Style 
opens. 

34 .Set the New Scale to 50 and click the OK button. 

35 .From Plan View Labeler, click the Place Label button and place the label 
following the same procedure used previously in this exercise. The finished label 
displays below. 

  

 

Exercise 6.3 Modifying a Style 
In this exercise, the user modifies an existing style having the wrong font built into it, 
which teaches how to update styles with errors. 

 TO MODIFY A STYLE 
1 . From the Styles tab, select the style Begin Project, and then click the Select Style 

Item button. 

  

2 . From the Plan View Labeler menu, select Scale > Change Scale. Scale Style 
opens. 

3 . Set the New Scale to 1, and then click the OK button.   
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4 . From the Params tab, Right click on the Text Preferences / Symbology window, 
click the Dialog option. 

  

5 . From Set Feature, set the Ft: (Font) option to FDOT (correct font for general text 
labels) from the pull down list. Click OK. 

   

6 . From the Styles tab, click the Update Style button. Update Style opens. 
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7 . On Update Style, click the OK button. 

  

8 . To change the Style Preview window, toggle between the Node and Shape Only 
and Complete Style options from the dropdown list. 

 

 

Note The preview may be different. When you place the label, the preview looks and works 
normally. You can also un-rotate the view and update the style again.  

9 . In the design file, zoom to the beginning of the project and place this label. 

Tip: Set the label scale to 50. 
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7 DRAW CELLS WITH GEOPAK 

DRAW CELL BY FEATURE 
GEOPAK has tools for drawing cells using data stored in Coordinate Geometry or 
along MicroStation elements. One of these tools, called Draw Cell by Feature, draws 
cells with a variety of options for many types of project scenarios. One example is 
drawing light poles, which place at specific stations and offsets. The cells used draw at 
even intervals along MicroStation elements by Feature through the  D&C Manager 
database, instead of searching through cell libraries. 

 TO OPEN DRAW CELL BY FEATURE 
From Road toolbox, click the Draw Cell by Feature button  

–or— From the MicroStation menu, select Applications > Road > Plans Preparation > 
Draw Cell by Feature. Draw Cell by Feature opens. 

 



Chapter 7 _____________________________________________________ DRAW CELLS WITH GEOPAK - Draw Cell by Feature 

7-2 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

 

 

 

Feature D&C Manager item defining the cell placed. The Feature label button 
opens a Design & Computation Pay item list. Select the appropriate item 
in the list to change the preview window. The items list all have a cell 
name defined. The cell name displays by clicking on the item list. 
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Placement Defines how to place the cell. The options are By Point and On Element. 

Angle  Defines the rotation of the cell. If set to Absolute, the Angle is based on 0 
degrees horizontal. If Angle has setting of Relative, then the angle is set 
relative to the selected element or chain. 

Element Defines whether to use a MicroStation element or a COGO chain as a 
reference to place the cell when selecting On Element. Click the Identify 
DGN Element button to select a MicroStation element in the design file 
or choose the COGO chain from the drop down list. 

Station  Used for determining the placement of the cell, upon selection of a chain. 

Offset  Distance from the MicroStation element or COGO chain to place the cell. 

Dynamic Rotation Allows the cell to rotate dynamically when placed. If not selected, 
the angle reads from the Angle box. 

Draw  Used to draw the cell into the MicroStation file. A prompt displays 
depending on the options selected in the dialog box. 
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DRAW CELL GROUP BY FEATURE 
Draw Cell Group by Feature draws groups of cells into a MicroStation file. The group 
of cells places in a graphic group based on user-defined spacing and offsets from 
MicroStation elements or COGO chains.  

 TO OPEN DRAW CELL GROUP BY FEATURE 
From Road toolbox, click the Draw Cell Group by Feature button  

–or— From the MicroStation menu, select Applications > Road > Plans Preparation > 
Draw Cell Group by Feature. Draw Cell Group by Feature opens. 

   

 



DRAW CELLS WITH GEOPAK - Draw Cell Group by Feature _______________________________________________ Chapter 7 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT 7-5  

FEATURE GROUP TAB 
The Feature Group Tab defines the features, offset and spacing, and the selected cells 
from the Design & Computation Pay item selection. 
For the placement of only one row of cells, click the Browse button in the center of the 
dialog and select the appropriate feature. There is no need to check the boxes if only in 
need of a single row of cells. Use the check boxes to add cells to the group of cells 
placed. 

 

Offset  Distance from the MicroStation element or COGO chain, defined on the 
Location tab, to draw the cell group.   

Upstream Spacing  Distance from Origin to Origin or Edge to Edge point of 
the cells, depending on which option selected. 

Downstream Spacing  Distance from Origin to Origin or Edge to Edge point of 
the cells, depending on which option selected. 

Draw  Initiates drawing the cell group(s) into the design file. Another data point 
on the MicroStation view is required to set the direction to offset the cell 
group. 

  



Chapter 7 _______________________________________________ DRAW CELLS WITH GEOPAK - Draw Cell Group by Feature 

7-6 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

LOCATION TAB 
The Location tab controls the placement of the cells according to a MicroStation element 
or COGO chain. 

 

Element: DGN Cells placed along a MicroStation element. Click the Identify DGN 
Element button to select the desired element. 

Element: Chain Cells place along a selected COGO chain. 

Begin / End  Specifies beginning and end placement of cells. If selecting a Chain, these 
are stations. If selecting a DGN, these are lengths of the MicroStation 
element. 

Buffer Distance Modifies the beginning and end stations or distance. The purpose is 
when the beginning or end station are known, but you must keep a certain 
distance inside the stationing. 

Note Example:  If the begin = 100.00 and the end = 600.00, the cells are drawn from 100 to 600. If 
the buffer distance = 30.00 and 40.00, then the real stations are: 130.00 (100.00 + 30.00) to 
560.00 (600.00 - 40.00). 

Spacing Six options are available: 

  Increment  Cells place at a set distance between cells. 

  Even  Cells place at a set distance starting at the next even value between cells.  
(i.e. Begin Station = 10+10 set with an even offset = 25.  The first cell 
placed at Station 10+25 then every 25’ thereafter) 

  Max Spacing  Maximum distance between cells placed between selected 
beginning and ending cells. 

  Once  Places a single set of cells. 

  Each Vertex  The origin of the cell placed at each vertex of the selected element. 

  Each Endpoint The origin of the cell placed at the endpoints of the selected 
element. 
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Angle  Places the cells at a specific angle value. If set to Absolute, the Angle is 
based on 0 degrees as horizontal. If set to Relative, the Angle is based 
relative to the selected MicroStation element or COGO chain. 

Justification The justification used for the placement of the cell. Options are center, 
upstream or downstream cell depending on the selections set on the 
Feature Group Tab.  

Draw   Draws the cell group into the MicroStation file. Prompts display 
depending on the options selected in the dialog box. 

 
Exercise 7.1 Drawing Cells by Feature 

 TO DRAW THE CELLS BY FEATURE 
1 . Run the executable file C:\Chapter7_Ex7_1.exe to extract the project files for this 

exercise. 
2 . Open C:\e\projects\96385275201\roadway\TCDSRD01.DGN. 

3 . From the Road toolbox, click the Draw Cell by Feature button. Draw Cell by 
Feature opens. 

  

4 . From Draw Cell by Feature, click the  Features label list button. Select Design 
& Computation Pay item opens. 

 

5 . Navigate to the 0102 74 1 Barricade (Temporary - Type I, II, VP & 
Drum)Drum item in the list.  
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6 . Modify the Draw Cell by Feature dialog as shown below. 

 

7 . Zoom in to the area from Station 105+00 to Station 108+00. 

8 . Click the Identify DGN Element button beside Complex Chain. 

9 . In the design file, click the edge line as shown below.  Data point again to accept 
the element.  

Tip:  Attach DSGNRD01.DGN as a reference file to match the illustration below. 

 

10 .From Draw Cell by Feature, click the Draw button. 

 

11 .Click again to accept the cell placement.   
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Exercise 7.2 Drawing Cell Groups by Feature 
 TO DRAW CELL GROUPS BY FEATURE 

1 . Open C:\e\projects\96385275201\roadway\TCDSRD01.DGN. 

2 . From the Road toolbox, click the Draw Cell Group by Feature button. 

  

3 . From the Feature Group tab, uncheck the check boxes on the left as shown below. 

 

4 . Click the Feature Group list item button. . 
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5 . Select the item 0120 74 1 Barricade (Temporary - Type I, II, VP & Drum). 

 

6 . From Draw Cell Group by Feature, type 26.00 in the Offset box.  

 

7 . From the Location tab, select Chain from the Element dropdown list. A dialog will 
pop up to select the gpk file. 

8 . At the right of the Element list, change the button to Chain. From the Item list 
select CL40 as the chain name. 

 

9 . In the Begin box, type 108+00.00. 
10 .In the End box, type 110+00.00. 

Tip: Alternatively, click the buttons to the right of Begin or End, and then click in the 
drawing on the corresponding Begin and End Stations to fill these boxes. 
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11 .Select Increment for the Spacing dropdown list and type 30.00 in the box. 

12 .In the Angle box, type 0.00 degrees and select Relative from the dropdown list. 

13 . Select Center Cell and Origin from the Justification dropdown lists. 

 

14 .Click the Draw button.  Data Point on the screen to accept the location to place 
the cells. 

 

Exercise 7.3 Drawing Cell Group by Feature (Transition) 
For this exercise, you will draw the barricades along the transition. 

 TO DRAW CELL GROUP BY FEATURE (TRANSITION) 
1 . From Draw Cell Group by Feature, select the Feature Group tab. 
2 . In the Offset box, type 2.00. 

 

3 . From the Location tab, click DGN from the Element dropdown list. 
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4 . Click the Identify DGN Element button. 

  

5 . In the design file, click the transition line and then again to accept.  

 

6 . In the Draw Cell Group by Feature dialog, type 30 in the Increment box. 
7 . Click the Draw button to draw the cells. Data Point to the left of the line to accept 

the direction of placement.   

8 . Close the Draw Cell Group by Feature dialog. 
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8 PLAN AND PROFILE SHEETS  

OBJECTIVES 
• Learn to create plan and profile sheets using the FDOT .psl file. 

• Create Motif Files. 

Plan/Profile Sheet Composition is the GEOPAK tool used to create Plan, Plan & Profile, 
or Profile sheets.  It provides two methods for the handling of MicroStation reference 
files. Motif Files are similar to MicroStation seed files, in the sense that Motif Files are 
design files that contain previously saved design file settings that apply to the newly 
created sheet files during the clipping process. If there is no need for a motif file, the 
settings of the clip border file transfer to the newly created sheet files. 

ACCESSING THE PLAN/PROFILE SHEET COMPOSITION DIALOG BOX 
 TO ACCESS THE PLAN/PROFILE SHEET COMPOSITION TOOL 

1 . From the Road toolbox, click the Plan/Profile Sheet Composition tool 

—or— From the MicroStation menu, select Applications > Road > Plans 
Preparation > Plan/Profile Sheet Composition  
—or— From Road Project, click the Plan/ Profile Sheet Compostion button.  
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2 . In Select Run, create a new run and click the OK button.  Plan Sheet Layout 
opens. 

Tip: Always create a Run based on the type and scale of sheets clipped, in case it is 
necessary to re-clip the sheets. 

 

GEOPAK SHEET LAYOUT OVERVIEW 
The Sheet Layout tool uses the concept of ports to define the areas to display. A port is a 
window into the design. There are three types of ports: Plan, Profile, and Tabular Data. 
The Sheet Layout tool supports any combination of these three ports.  

For example, users can double stack plan ports to accommodate Traffic Control plans 
where there is no profile. The Sheet Layout tool allows the automatic placement of 
borders used to define the boundaries of sheets along a GEOPAK alignment. 

 

FILE MENU 
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 TO ATTACH A DIFFERENT SHEET LIBRARY 
From the Plan Sheet Layout menu, select File > Sheet Library > Attach.  Attach 
Sheet Library opens. 

FDOT delivers Sheet Libraries with the FDOT2010 software. The Sheet Libraries are 
located in the directory FDOT2010\geopak\dat_files.  When changes are necessary, 
FDOT recommends storing a copy of the delivered Sheet Library in the project directory 
under the symb folder.  

Find detailed information on the set-up of the Sheet Library in the online help section 
entitled "Sheet Library Set-up." 

 TO REVIEW OR MAKE CHANGES TO THE SHEET LIBRARY 
To review or make changes to the Sheet Library, select the Plan Sheet Layout menu 
option File > Sheet Library > Edit. Sheet Layout: Sheet Library opens. 

The Sheet Library defines the parameters for each project sheet.  In order to layout, or 
clip, sheets, the user must attach a Sheet Library to the current session.  The name of the 
currently attached Sheet Library displays in the title bar and has an extension of .psl.  A 
number of different sheets can be stored within one library.  

 

Cell Library Currently attached cell library.  

Sheet Cell This is a required sheet cell entry from attached cell library.  

Sheet Cell Placement A user preference defining how to handle the sheet border, either 
placed in each sheet or placed in a reference file. 

Note FDOT provides standard sheet border files, BD*.dgn, depending on the type of sheet to be 
clipped. 
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VIEW MENU 

 

Filter by Sheet Name  The clipping shapes of the currently selected sheet name 
will display.   Use MicroStation update view, if Automatic Update is set to 
off. 

Filter by Scale The clipping shapes of the currently selected scale will display. 
One must use MicroStation update view, if Automatic Update setting is 
off. 

Automatic Update When the Automatic Update setting is on and the Filter by Sheet 
Name or Filter by Scale selected, the view is automatically updated. 

Settings Menu 

 

Sheet Layout  Option to open the Sheet Layout Settings dialog.  

 

 Sheet Layout Progression  Includes two options, Left to Right (Standard) and 
Right to Left (Rail) 

  Profile Stair Stepping   Select On if to stair step the profile in areas of great 
relief. If not, select Off. 
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 Sheet View Attributes   Two options described below: 

o Use Current Design File

o 

   The reference files, attached to the 
completed plan and profile sheets, read from the current design file 
when the clipping sheets and uses the level symbology from the active 
file for each clipped sheet.  The active design file attaches to each port 
in the clipped sheets as a reference file. 

Customize with Motif Files

TOOLS MENU 

 The motif file determines which files to 
attach, not the active design file, including reference level structure. 
The Motif file is a MicroStation design file the user creates. 

 

Identify Sheet  Select a previously placed clipping boundary or border. GEOPAK 
determines the settings to use to place the original boundary or border and 
automatically populates the Plan Sheet Layout with the Sheet Name and 
Scale. In addition, the Sheet Name, Scale, Sheet Number and Port display 
in the MicroStation status bar. 

Sheet Composition Opens Plan Sheet Layout: Sheet Composition, wherein defines 
drawing area, overlapping options and other project specific variables.  
Sheet boundaries draw into the file using an alignment chain from COGO.  
Curves use the chord for any optional offsets defined.  The graphic in the 
dialog box depicts the required variables defined in the Clip portion of the 
dialog. 
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  Clipping Modes There are four options for calculating how the sheet 
boundaries or borders are calculated and drawn. 

 

  By Begin Station/Overlap Mode that calculates the clipping area to include an 
overlap between the sheets. 
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o Maximum Drawing Area

o 

   Calculated by GEOPAK based on the 
Sheet Name library settings and the Scale selected in Plan Sheet 
Layout.  In our example, the Maximum Drawing Area is 700.00 x 
200.    

Horizontal

o 

  Computation subtracts twice, once for the right side and 
once for the left side.  In this case, the calculation is 700.00 - 10 - 10 = 
680.00, as shown in the Drawing Shown box and the Active Drawing 
Area. 

Vertical

o Drawing Shown This is the distance along the alignment, shown on 
the plan sheet. 

   Computation subtracts twice, once for the top and once 
for the bottom.  In this case, the calculation is 200.00- 10 - 10 = 
180.00, as shown in the Active Drawing Area.   

o Overlap

 

   Fixed Distance option, the value is in master units, i.e., 
feet or meters. Percentage option, type the desired overlap in percent 
format in the Overlap box.  The two options are shown below: 

Note The percent sign (%) is not required. The Percentage will calculate utilizing the Drawing 
Shown value. When placing sheets on a curve, the sheet orientation utilizes the intersection 
of the chord of the curve and the inside border. 

Since the By BeginStation/Overlap option uses a chord distance to 
compute the length of the sheet, in the area of a curve more stationing is 
covered. On a Plan/Profile sheet, using this option means that unequal 
coverage occurs between the Plan and Profile.  With this in mind, use By 
Begin Station/Overlap option for a Plan only case. 

 

   

  



PLAN AND PROFILE SHEETS - GEOPAK Sheet Layout Overview ___________________________________________ Chapter 8 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT 8-9  

By Station Range Inside Out  Orients sheets between rounded station intervals.  
One enters the interval in the Station Range box.  

Note The Station Range is a factor of the Clipping Scale. Look in the PPM, Volume 2, Chapter 10, 
for the values used. These values are filled in based on the scale entered, but may need to 
be adjusted to fix areas in sharp curves where portions of the design files are missed. 

 

  When computing a sheet length with a constant station range, the resultant 
sheet length varies when sheets place along a curve.  

  Now the Active Drawing Area is not constant, but displays variable in the 
output field.  For each sheet, the length computes for all that are 
corresponding to station coverage of 600. The length increases by two 
times the horizontal value. Therefore, along a tangent section, the sheet 
length is 600 + (2 x 50) = 700. 

  Along a curve, the sheet length is shorter. Each sheet is individually 
constructed based on the Horizontal, Vertical and required sheet length to 
cover the desired station range. 
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By Station Range: Outside In  Orients sheets between a rounded station interval. 
One enters the interval in the Station Range box.  

 

  The difference between Outside In and Inside Out is in the usage of 
Horizontal.  For the Inside Out mode, the horizontal distance expands the 
lateral dimension of the clipping shape.  For the Outside In option, the 
Horizontal distance trims the Station Range instead. The Maximum 
Drawing Area, Horizontal and Station Range are inter-related.  

   In the preceding figure, Maximum Drawing Area: 700.00 x 270.00. 

  To trim the Station Range by 20.00 feet, type the value 10.00 in the 
Horizontal box. GEOPAK then re-calculates the Drawing Area.   

  Station Range = 700.00 – (2 x 10.00) = 680.00 

  However, the Horizontal value must be an integer (based on the Grid 
Alignment value in the GEOPAK Sheet Layout: Sheet Library). 
Therefore, the Horizontal value needs to round to the nearest integer and 
the Station Range adjusted accordingly. 
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   If the Grid Alignment values are set to 0, no adjustment occurs. The 
preceding figure shows the Horizontal value set to 1.0.  

   Clipping shapes computed with the Outside In option never overlap along 
tangent sections, but do have slight overlap (or gaps) on the top and 
bottom of the sheets along curves due to the wedging effect. 

  By Station Range: Radial Option identical to the Outside In option, except 
the resultant clipping shapes are not rectangular. Instead, the Vertical 
edges are oriented perpendicular to the alignment, which results in 
rectangular shapes along tangent sections and more of a trapezoidal shape 
along curved sections. 
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   As shown in the preceding figure: 

o Maximum Drawing Area = 700 x 200 

o Horizontal = 0.00 

o Station Range = 700.00 – 0.00 = 700.00 

  If, instead a Station Range of 600.00 is entered, the Horizontal value is 
readjusted to 

o Horizontal = (700.00 – 600)/2 = 50.00 

  When the clipped sheets lay out, a rectangular area equivalent to the 
Maximum Drawing Area (700.00) will construct. Then radial lines at the 
match lines compute and the region of the maximum drawing extents, 
within the radial station lines, compute, forming the finished clipping 
shape. 

  The clipping shapes constructed with this mode never overlap.  However, 
take care in computing the maximum drawing area in that gaps do not 
result on the outside of curves, referred to as the pie shaped wedges as 
shown below. To fix this condition, decrease the Station Range until the 
wedges disappear. 
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Sheet Layout This menu option opens the Plan Sheet Layout: Layout Settings dialog 
and used to define the GEOPAK Job Number, alignments, and/or profiles 
for the desired sheets. 

    

   Used to place clip borders in the current design file along a GEOPAK 
alignment specified by the user. This requires defining a GEOPAK COGO 
database job file.  

 TO SELECT A GEOPAK JOB (.GPK FILE) AND LAYOUT SHEETS 
1 . From Plan Sheet Layout: Layout Settings, click the Open GPK Job button 

beside the Job box. Job Number opens. 

 

2 . From Job Number, click the .gpk file number that will be used to layout the 
sheets.  

3 . Click the Ok button. The Job Number selects and Job Number closes. 

 

4 . From Plan Sheet Layout: Layout Settings, select the Single Sheet or Multiple 
Sheets option.  
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Note The large list box in the middle of Plan Sheet Layout: Layout Settings 
displays the Port information.  

5 . Double-click one of the ports displayed in list. Plan Sheet Layout: Plan Port 
Data opens.  

6 . From Plan Sheet Layout: Plan Port Data, select a chain from the Chain list.  

7 . In the Offset box, type an offset from the chain.  

8 . In the Motif File box, type in the name of the motif file or browse to select or 
create the file.  
Note The default settings are to use the active design file settings. 

  

9 . Click the OK button to save the settings and dismiss the dialog.  

10 .(Optional)  If the sheet has more than one port, then steps 4 through 8 repeat for 
each port. 

11 .From Plan Sheet Layout: Layout Settings, Enter the Begin Station  
--or-- click the Select Begin Station button at the right, then click in the design file 
to graphically select the station.  

12 .Enter the End Station 

--or-- click the Select End Station button at the right, then click in the design file 
to graphically select the station.  

13 .If the sheet laid out has more than one port, repeat the steps to define the required 
ports. 
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14 .To lay out the borders, click the Layout Sheet button.  
Note If placing multiple sheets, the number of sheets placed displays on the button. 

Important:  There may be times that require laying out the clip borders again, because of 
intersections or alignment changes. Delete the original clip boundaries, and then compress the 
MicroStation design file before running layout a second time. 

 

Important:  Reference the Profile design file to the clipping file in order for the profile cell to be 
recognized. 
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Sheet Clip Option to open Sheet Layout: Clip Sheets dialog and used to clip sheet 
borders out to sheet files. The dialog box has three sections, as shown 
below: Output File, Labels and Annotations, and Create Digital InterPlot 
Plot Set.  FDOT does not support InterPlot. 

 

  Output File  Settings define where and how to create the sheet files.  

o Directory

o 

  Sets the path where to create the new sheet files. 

Sheet Name Prefix

o 

  File name to use to create new sheet files.  
Type only the first part of the file name; the software supplies a 
numerical suffix that corresponds with the sheet number. For example, 
if “plprrd” is entered as the prefix, as the sheets are clipped the files 
are named plprrd1.dgn, plprrd2.dgn, etc. 

Orientation

o 

  Rotate Reference option rotates all of the references 
files attached to the clipped sheets. Use only if you want to stack 
sheets in one file.  Rotate View option rotates the MicroStation view. 

Sheets per File

o 

  Sets the number of sheets to place in a file before 
creating another sheet file.  Note:  FDOT does not recommend placing 
more than 10 sheets per file.   

Sheet Range Begin/End

  

 Select the range of sheets created from the 
clip borders.  
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  Labels and Annotations  Defines labels placed on the sheets.  The sheet 
library defines the placement of the labels.  If not defined in the sheet 
library, the option will not be available and ghosted out.  

o Sheet Title

o 

   Title drawn on the sheets. 

Project Number

o Match Line  Text added with the station value on match lines. 

  Project number drawn on the sheets. 

o Auxiliary Sheet Annotations

o 

  Plots additional sheet information 
into the clipped sheets if selected. The additional information is Sheet 
Number, Rotation Angle and Chain Name. This is an optional setting. 

Process Sheets

  Create Digital InterPlot Plot Set Allows the creation of the Digital InterPlot 
Plot Set during the Layout Sheets process. 

  Starts the clipping process. During this process, new 
design files create and the sheets clip according to the clip border 
boundaries. When the clipping process finishes, MicroStation goes 
back into the clipping file not the clipped sheet. 

Sheet Modify  This command opens Plan Sheet Layout: Modify, which 
operates in two modes, Slide Sheets or Modify Drawing Area, represented 
by the two buttons in the upper left corner. The figure below shows the 
Slide Sheets mode. 
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  Slide Sheets  Used to move the clip borders along the alignment. For example, 
the sheets shift so that an intersection displays all on one sheets instead of 
broken up onto two sheets.  

o Shape

o 

  Identifies the active clip boundary modified.   
Id

o 

   Selects the boundary from the MicroStation element and 
sets it to the active Shape. 

Slide Preceding Sheets

o 

 Makes the preceding sheets slide along with 
the current sheet if selected. 

Slide Following Sheets

o 

 Makes the following sheets slide along with 
the current sheet if selected. 

Station

  Left Edge Station, Center Station or Right Edge Station.  To move the 
boundary along the alignment to the new station type a new station value 
into the station display box.  

  Defines the location of the displayed station:  

   These options refer to the portion of the clip border that is located at that 
station: 

o Extend 

o 

Value    In master units, used to move the boundary 
along the alignment.   
Sheet Chord Offset 

o 

 Allows the movement of the sheet parallel to the 
alignment in either direction for a given distance.  

Additional Rotation

o 

 This angle is a measurement from the left 
station and is in reference to the alignment. 

Dynamic

o 

    This button performs Extend, Sheet Chord 
Offset, or Additional Rotation about Left Station dynamically.  

Apply

   

      Processes the change. 
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  Modify Drawing Area   Changes the composition of the borders. An 
example of when this tool is used is if a sheet needs to show less than the 
standard 700 feet of coverage. Set the Drawing Shown value to 500 and 
the sheet clip boundary adjusts to that value.  

  

o 

 Hold To Maintains the position of the sheet Left Station, Center 
Station, or Right Station and adjusts in other directions.  

Lateral Dimensions 

 Drawing Shown Value for the total length of drawing shown on 
the sheet.  

 Horizontal   This is the value to extend the sheet horizontally.  

o Vertical

o 

 This is the value to extend the sheet vertically. 

Apply

Sheet Number Manager The user utilizes the Sheet Number Manager tool to adjust 
the sheet numbering and sequencing.  The list box contains sheets to clip. 
In the case of dual clip borders for a single sheet, i.e. Plan/Profile sheets, 
the borders group together and only list once in this window. 

  Processes the changes. 
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   Move Sheet Up  Moves a selected sheet up in the order. This is 
useful if placing a sheet using the Place Single Sheet option and others 
using the Place Multiple Sheets option. Reorganizing sheets can be before 
clipping them to the plprrd.dgn file. 

   Move Sheet Down Select a sheet and then click this button to move the 
sheet down in the order.  

   Edit Sequence Number Opens Edit Sequence Number used to edit the 
sequence number of the drawing. 

   Edit Sheet Number Opens Edit Sheet Number used to modify the 
sheet number, add prefix and suffix, and perform other labeling options. 

    The actual sheet file name is set during the clipping process. For 
example, use this tool to number the sheets prior to clipping by adding the 
sheet number prefix to each sheet, i.e., Plprrd01.dgn where 0 is the prefix, 
as shown below.  When clipping the sheet, the Plprrd comes from Clip 
Sheets and the Sheet Number Manager tool adds the prefix.  

 

   Identify Sheet  Selects a sheet graphically to modify. Select the Highlight 
Clipping Shape check box or Window Center Clipping Shape for 
highlighting or centering selected sheets in your MicroStation window. 
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Draw Tabular Annotation (Sheet Clip Mode) Setting the Port Type to Tabular 
utilizes the Draw Tabular Annotation (Sheet Clip Mode) tool. The tool 
defines the clipping shape to include the tabular data on the sheets. 
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GEOPAK SHEET LAYOUT BUTTONS 
These buttons open the same tools discussed and detailed earlier in this chapter. 

 Sheet Composition (Tools > Sheet Composition). 

 Layout Sheets (Tools > Sheet Layout). 

 Clip Sheets (Tools > Sheet Clip). 

 Modify Sheets (Tools > Sheet Modify). 

 Sheet Number Manager (Tools > Sheet Number Manager). 

 Identify Sheet (Tools > Identify Sheet). 

SHEET NAME SELECTOR AND PLOT SCALE 
Plan Sheet Layout has two global parameters:  Sheet Name Selector and Plot Scale. 

 

Sheet Name Selector  Drop-down list displays all sheets in the currently attached 
Sheet Library. 

Plot Scale Sets the scale for placing sheets in the layout file. 
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Exercise 8.1 Creating Motif Files 
In this exercise, the user creates the Plan and Profile Motif design files and attaches 
references to clip with the sheet sheets. 

 TO CREATE MOTIF FILES 
1 . Run the executable file C:\Chapter8_Ex8_1.exe to extract the project files for this 

exercise. 

2 . Open DSGNRD01.dgn in C:\e\projects\96385275201\roadway. 

3 . Select the FDOT Menu option Actions > Create/Edit File.  Create File/Project 
opens. 

4 . Verify that the Project and Control File are set as shown below. 

 

5 . In the File Group field, click the down arrow and select Roadway Design Files 
(DGN). 
Note Output Folder, Seed File, and Seed Path are automatically set when setting the File Group 

field. 

 



Chapter 8 ___________________________________________ PLAN AND PROFILE SHEETS - GEOPAK Sheet Layout Overview 

8-24 © 2011 FDOT FDOT GEOPAK for Roadway Designers - Basic 

6 . Under File Type, select MOTIF FILE FOR PLAN SHEETS.  The file name 
MTPLRD01 appears in the Output File box.   

7 . Click the Create button.  Create/Edit File information box opens.  

 

8 . From Create/Edit File, click OK to close and the Open DGN button becomes 
available.  

Note The file name entered in the Output File box increments to MTPLRD02. 

9 . Click the Open DGN button.  The file MTPLRD01.dgn opens. 

10 .Click the OK to close Create File/Project. 
11 .Set/Update Plot Scale automatically opens.  

Set the Plot Scale to 50. 

 

 

 

 

 

12 .Click OK. The plot scale of the file is set and Set/Update Plot Scale closes. 
13 .Attach the following Reference Files for the Plan View: 

• C:\e\projects\96385275201\roadway\ALGNRD01.dgn;model ALGNRD_50 

 

• C:\e\projects\96385275201\roadway\DSGNRD01.dgn 

• C:\e\projects\96385275201\survey\TOPORD01.dgn 

• C:\e\projects\96385275201\survey\UTEXRD01.dgn 

Note If no raster images are included, turn off the Display Raster References option. 
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14 .Select from MicroStation, Settings > Levels > Display. The Level Display 
dialog appears.  

   

15 .Set the level structure for each reference file as shown below: 

o Dsgnrd01 

o 

– Turn Off Level:  PointLocator_ep. 

Topord01

 BLSurveyField_ep 

 – Turn Off Levels: 

 BLSurveySymbl_ep 

 Default 

 Pavemk_ep 

 PavtCrown_ep 

 SignalMisc_ep 

 SignSupport_ep 

 Slopes_ep 

 TextBLStation 

 TextMisc 

 TopoMisc_ep 

 Tower_ep 
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o Utexrd01 
 Default 

– Turn Off Levels: 

 LeaderLine_dp 

 SignalMisc_ep 

 SignalSupport_ep 

 SignSingle_ep 

 Slopes_ep 

 TextMisc 

 Trash_ep 

16 .In MicroStation, Fit View, and then select the menu option File > Save Settings. 

17 .Select the FDOT Menu option Actions > Create/Edit File. Create File/Project 
opens. 

18 .In the File Type, select MOTIF FILE FOR PROFILE SHEETS.  The file 
MTPRRD01 appears in the Output File box.   

19 .Click Create.  Create/Edit File opens. 

20 .From Create/Edit File, click OK to close.  The Open DGN button becomes 
available and the file name in the Output File box increments to MTPRRD02. 

21 .Click the Open DGN button.  The file MTPRRD01.dgn opens. Click OK to close 
Create File/Project. 
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22 .Set/Update Plot Scale automatically opens.  Set the Plot Scale to 50. 

 

23 .Click the OK button. The plot scale of the file is set and Set/Update Plot Scale 
closes. 

24 .Attach the Reference File for the Profile View. 

 C:\e\projects\96385275201\roadway\DSPFRD01.dgn. 

25 .Turn off Level XSCell in the profile reference file. 

26 .From MicroStation, Fit View and then click File > Save Settings. 
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Exercise 8.2 Creating the Clip Borders Design File 
In this exercise, the user creates the design file for the GEOPAK Clip borders.  

 TO CREATE THE CLIP BORDERS DESIGN FILE 
Important: Do not create the GEOPAK Clip borders in the main design file. 

1 . Select the FDOT Menu option Actions > Create/Edit File.  Create File/Project 
opens. 

2 . In Create File/Project, select Roadway Design Files (DGN) in the File Group 
list. 

3 . In the File Type list, select CLIP BORDERS. 
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4 . Click the Create button to create the clip border file. 

5 . Click the Open DGN button to open the clip border file. 

6 . Set/Update Plot Scale opens and is set to 50.0, click OK to close. 

7 . From Create File/Project. click the OK button to close. 

8 . Reference in the following drawings: 

o C:\e\projects\96385275201\roadway\DSGNRD01.dgn 

o C:\e\projects\96385275201\roadway\DSPFRD01.dgn 
9 . From Road Project, click the Plan & Profile Sheets button. Select Run opens. 

 

  

10 .To create a run, select menu option Run > New. New Run Name opens.  
11 .In the New Run Name box, type Mainline along with a description as shown 

below.  
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12 .Click the OK button. New Run displays in Select Run. 

   

13 .In Select Run, select Mainline, and then click the OK button. Plan Sheet 
Layout opens. 

14 .On the FDOT Menu, click Standard > Explore FDOT2010 Directory.  In 
Explorer, navigate to C:\fdot2010\GEOPAK\dat_files.  Right click on the file 
rdplan.psl and select Copy. 
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15 .Navigate to the project directory, C:\e\projects\96385275201\symb. Paste the 
rdplan.psl file in the symb directory. 

 

16 .In Plan Sheet Layout, select the menu option File > Sheet Library > Attach.  
Attach Sheet Library opens. 

 

17 .In Attach Sheet Library, navigate to the symb folder in the project directory.  
Select rdplan.psl and click Open. 
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18 .In Plan Sheet Layout, select the Sheet Name PLPR50.   

  

19 .Set the Scale to 50.00ft/in.   

  

20 .Select the Plan Sheet Layout menu option Settings > Sheet Layout. Sheet 
Layout Settings opens. 

  

21 .Change the settings to match the figure below, and then click the OK button. 

 

22 .Select the Plan Sheet Layout menu option File > Sheet Library > Edit. Sheet 
Layout: Sheet Library opens. 

   

23 .In Sheet Layout: Sheet Library, select the category Port 1 (Plan) > Match 
Lines. 

  



PLAN AND PROFILE SHEETS - GEOPAK Sheet Layout Overview ___________________________________________ Chapter 8 

FDOT GEOPAK for Roadway Designers - Basic © 2011 FDOT 8-33  

24 .Toggle on the check box for Match Lines. 

 

25 .Click the Close button in the upper right hand corner of the dialog box. Alert 
opens. 

26 .From Alert, click the Yes button to save the changes made to the Sheet Library. 

   

27 .In Plan Sheet Layout, click the Sheet Composition button. GEOPAK Sheet 
Layout: Sheet Composition opens. 

   

28 .From Plan Sheet Layout: Sheet Composition, click the By Station Range: 
Radial option.  
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29 .Change the information on Plan Sheet Layout: Sheet Composition to match as 
shown below. 

  

Important:  Ensure that the Station Range sets to 700.00 for a 50 scale Plan and Profile sheet. If it is 
set any larger, the profile clips will come out wrong. 

30 .Click the Close button in the upper right hand corner of the dialog box. 

31 .In Plan Sheet Layout, click the Layout Sheets button. Plan Sheet Layout: 
Layout Sheets opens. 

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            

32 .Click the Open GEOPAK Job button next to the Job box. Job Number opens.  

     

33 .On Job Number, select job527.gpk and click OK. The Job is set and Job Number 
closes. 
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34 .Set the method to Multiple Sheets. 

35 .Double-click Port 1. Plan Sheet Layout: Plan Port Data opens. 
36 .From the Chain dropdown list, select CL40.  

 

37 .For the Motif File, click the Select Motif File button. Select Plan Port Motif File 
opens. 

 

38 .Select the MTPLRD01.dgn file and click Open.   

39 .Click OK on the Plan Sheet Layout: Plan Port Data dialog box. 
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40 .In Plan Sheet Layout: Layout Sheets, double-click Port 2. Plan Sheet 
Layout: Profile (PGL) opens. 

 

41 .In Profile, select EXGROUND. 
42 .From the Chain dropdown list, select CL40. 

43 .In MicroStation, zoom to the Profile Cell. 

44 . In Plan Sheet Layout: Profile (EXGROUND), click the Identify Cell button. 

45 .Click the purple profile cell. The remaining data appears in the dialog box. 
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46 .Under Motif File, click the Select Motif File button. Select Profile Port Motif 
File opens. 

 

 

47 .Select MTPRRD01.dgn and click Open.  

48 .Click the OK button. Plan Sheet Layout: Profile (EXGROUND) closes. 
Note The station range and number of sheets calculates as shown below. 

 

49 .From Plan Sheet Layout: Layout Sheets, click the Layout 29 Sheets button. 
50 .Click the Close button. 

51 .In MicroStation, review the Plan and Profile clip borders. 
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52 .In the plan area, zoom to the first curve and notice the clip borders and the pie-
shaped wedge of missing data.  

Tip: To fix situations like this, open Sheet Composition, set the Station Range to a 
smaller value(i.e. 660), and lay out the clip border again. Delete the first clips and 
compress the design file. For the training class, we will leave these as they are. 

 
 

Exercise 8.3 Creating Plan & Profile Sheets 
In this exercise, the clipping process continues by setting up the sheet naming and 
numbering, then creating the sheets. 

 TO CREATE PLAN & PROFILE SHEETS 
1 . From Plan Sheet Layout, click the Sheet Number Manager button.  Plan Sheet 

Layout: Sheet Number Manager opens. 

 

2 . On Plan Sheet Layout: Sheet Number Manager, select the first sheet in the 
list, and then click the Edit Sheet Number button. Edit Sheet Number opens. 
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3 . On Edit Sheet Number, toggle on the Add Prefix check box and enter 0 in the 
box. Click the OK button. 

 

4 . Repeat this process for sheets 2-9. 

Tip: Select the first sheet, hold the Shift key, and then click sheet 9 to hightlight all of the 
sheets at one time.  

Note The following shows the completed task. Notice sheets 1 through 9 now have a 0 in front of 
the number.  

 

5 . Click the Close button to close Plan Sheet Layout: Sheet Number Manager. 
Alert opens. 

6 .  In Alert, click the Yes button to save the modifications. 

7 . From Plan Sheet Layout, click the Clip Sheets button. Plan Sheet Layout: Clip 
Sheets opens. 
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8 . To set the Directory, click the Open button next to the entry box and navigate to 
the Roadway folder as shown below. 

 

9 . In the Sheet Name Prefix box, type PLPRRD and click the Tab key.   

Important:   This tool reads in the modifications in Sheet Number Manager and names the files 
PLPRRD01, 02… up to number 10. This step replaces renaming the files through Windows Explorer.  
In addition, if Sheet Number Manager was not used, but instead a 0 typed in the Sheet Name Prefix 
box on this dialog box, all of the sheets including 10 through 29 will include a 0 in the name. 

Note  Labels and Annotations is not used.  These fields on the plan sheet fill in with Sheet 
Navigator.  

10 .From the Orientation dropdown list, select the Rotate Reference setting.   
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11 .From the Sheet Range End dropdown list, select 10.  

 

Tip: Process only a few of the sheets the first time to make sure everything looks good, 
then go back and clip the remaining sheets.  

Note Step 12 included to save time in the class. 

12 .Click the Process Sheets button. When the processing is finished, close Sheet 
Layout: Clip Sheets. 

13 .Close Plan Sheet Layout.  

14 .In MicroStation, open PLPRRD01.dgn in the Roadway folder and review the file. 
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